# Table of Contents

1 Introduction to MADSEN Xeta .......................................................... 7  
  1.1 The OTOSuite Audiometry Module .................................................. 7  
  1.2 Intended use ................................................................. 8  
  1.3 About this manual .......................................................... 8  
  1.4 Typographical conventions ....................................................... 9  
      1.4.1 Navigation ......................................................... 9  

2 Getting started ................................................................................. 10  
  2.1 Patient data ........................................................................... 11  
      2.1.1 Clearing test data ....................................................... 12  
      2.1.2 Viewing results ......................................................... 12  
  2.2 Preparing the patient .............................................................. 12  
  2.3 Automatic Air Conduction testing ............................................. 12  
      2.3.1 Automatic Threshold testing ....................................... 12  
      2.3.2 Automatic Screening .................................................. 13  
  2.4 User-defined tests ................................................................... 14  

3 Overview of MADSEN Xeta .............................................................. 15  
  3.1 Display ................................................................................ 15  
  3.2 Front panel controls ............................................................... 16  
      3.2.1 Front panel layout ....................................................... 17  
      3.2.2 STIMULUS .............................................................. 17  
      3.2.3 MASKING .............................................................. 18  
      3.2.4 TEST .................................................................... 18  
      3.2.5 Signal indicators ......................................................... 19  
      3.2.6 Extended Range ......................................................... 19  
      3.2.7 Clear ...................................................................... 20  
      3.2.8 Patient handling buttons .............................................. 20  
      3.2.9 Setup ..................................................................... 20  
      3.2.10 Change Ear (L <-> R) ............................................... 21  
      3.2.11 Store/toggle threshold status ..................................... 22  
      3.2.12 Response indicator ..................................................... 22  
      3.2.13 Stimulus/masking intensity knobs ................................ 22  
      3.2.14 Present signal buttons ................................................ 23  
      3.2.15 Frequency .............................................................. 23  
      3.2.16 Talk Over .............................................................. 23  
      3.2.17 Mic. (microphone) ...................................................... 24  
      3.2.18 Start/Pause ............................................................. 24  
  3.3 Socket connections - rear panel ............................................... 24  

4 Navigating in the OTOSuite Audiometry Module ............................... 27  
  4.1 Audiometry Module features .................................................. 27  
  4.2 The Audiometry Module menu system and toolbar .................... 28  
      4.2.1 File menu ............................................................. 28  
      4.2.2 Edit menu ............................................................. 28  
      4.2.3 View menu ............................................................ 28  
      4.2.4 Tools menu ........................................................... 30  
  4.3 The Patient Responder indicator ............................................. 31  
  4.4 The Masking Assistant .......................................................... 31
4.5 The Audiometry Module Control Panel ................................................................. 34
  4.5.1 The Control Panel .................................................................................... 34
4.6 The stimulus bar ................................................................................................. 35
  4.6.1 The Tone stimulus bar .............................................................................. 36
4.7 The Tone test screen .......................................................................................... 36
  4.7.1 The work area in the Tone screen .............................................................. 37
  4.7.2 The audiogram ......................................................................................... 37
  4.7.3 Curves and symbols selection ................................................................. 39
    4.7.3.1 Selecting a symbol or curve ............................................................. 39
    4.7.3.2 Creating new symbols .................................................................... 40
  4.7.4 Compare audiograms ............................................................................... 41
  4.7.5 The Legend box ....................................................................................... 41
  4.7.6 Tone view options .................................................................................... 41
4.8 Work-flow related features ............................................................................... 43
  4.8.1 Selecting orientation ............................................................................... 43
  4.8.2 Ear shift frequency and level setting ....................................................... 43
5 Preparing for testing ............................................................................................ 45
  5.1 Preparing the test environment ..................................................................... 45
  5.2 Preparing the test equipment ........................................................................ 45
    5.2.1 Connecting the cables of the test equipment ...................................... 46
    5.2.2 Patient record lists ............................................................................... 46
    5.2.3 The patient responder ......................................................................... 47
    5.2.4 Preparing for air conduction testing .................................................. 47
    5.2.5 Preparing for bone conduction testing ............................................. 48
    5.2.6 Preparing for testing with masking ..................................................... 49
  5.3 Listening check .............................................................................................. 49
  5.4 Preparing the client ....................................................................................... 50
    5.4.1 Hygienic precautions .......................................................................... 50
    5.4.2 Inspecting the client’s ear(s) ................................................................. 50
  5.5 Preparing the Audiometry Module for testing ............................................. 50
  5.6 Proper transducer placement ........................................................................ 50
  5.7 The client/patient list .................................................................................... 52
    5.7.1 Create patients for the patient list ....................................................... 52
    5.7.2 Transfer the patient list to the audiometer ......................................... 52
  5.8 Fetch test results from audiometer .............................................................. 52
  5.9 Preparing the patient for testing .................................................................. 53
6 MADSEN Xeta Test Settings ............................................................................... 55
  6.1 Test-specific settings ..................................................................................... 55
    6.1.1 Auto Threshold test settings ............................................................... 55
    6.1.2 Auto Screening test settings ............................................................... 56
  6.2 General settings ............................................................................................ 58
    6.2.1 Return to default settings ................................................................... 58
  6.3 Items in the Setup menu ............................................................................... 59
7 Testing a patient with MADSEN Xeta .................................................................. 67
  7.1 Automatic tone testing .................................................................................. 67
  7.2 Manual tone testing - getting started .......................................................... 67
  7.3 Air Conduction threshold test (manual) ...................................................... 67
  7.4 Bone Conduction threshold test (manual) .................................................. 70
  7.5 Testing with masking ................................................................................... 72
    7.5.1 Air conduction with masking - suggested procedure ......................... 72
# Introduction to MADSEN Xeta

MADSEN Xeta is an audiometer for testing a person’s hearing. MADSEN Xeta offers air and bone audiometry as well as masking. Besides manual testing, MADSEN Xeta employs fast automatic screening and threshold audiometry algorithms. MADSEN Xeta incorporates multi-patient data storage and patient testing according to a pre-loaded patient list.

- MADSEN Xeta can be used in connection with the OTOsuite Audiometry Module software for online monitoring of test results, data export and storage, printing, and NOAH compatibility.
- Test intensities and frequencies as well as the current test settings and other information are shown on the PC monitor.
- A patient list can be edited in the software and downloaded to MADSEN Xeta.

## Operation

The front panel buttons have indicator lights, which clearly show the device’s current settings.

Sound level, frequency and other information are shown clearly on the device display.

You can download new firmware to MADSEN Xeta, and if this involves no change to the transducers, MADSEN Xeta does not need to be recalibrated.

## 1.1 The OTOsuite Audiometry Module

The OTOsuite Audiometry Module software provides a comprehensive overview of the current stimulus and masking choices both numerically and graphically in the displayed audiogram(s) while testing with a connected Otometrics audiometer.

As the module is part of OTOsuite, audiograms can be used directly in other OTOsuite modules such as AURICAL Counseling and Simulations for an optimized workflow independent of NOAH.

The OTOsuite Audiometry Module lets you work with NOAH or save and view results via XML files.

The current version supports
- basic tone audiometry and
- speech testing
- special tests, depending on the audiometer being used.

## Masking Assistant™

The special Masking Assistant™ feature will notify you of thresholds that you might consider checking again with masking applied. You may use this feature not only during testing but also to pinpoint possible masking issues with previously recorded audiograms. The applied masking rules match the general recommendations in the audiometry literature.

## Over the rim testing

Testing with the audiometer connected to a PC allows you to use the audiometer primarily as a handy control panel while you follow the actual stimulus settings and test progress on your standard PC display. The large stimulus and patient response graphics at the top of the display gives you a clear overview while keeping your focus on the patient.
Patient test planning
The OTOsuite Audiometry Module supports planning of patients for safe offline testing in the field. You can create a list of patients which can then be downloaded to the audiometer. Each planned patient can now be safely identified, selected and tested with the audiometer based on name and personal identification. The results can be bulk uploaded to the PC later on.
For specific information regarding audiometric test procedures and settings, please see the documentation for the specific audiometer.

1.2 Intended use
MADSEN Xeta and the Audiometry module
Users: audiologists, ENTs and other health care professionals in testing the hearing of their patients.
Use: screening and diagnostic audiometric testing.

1.3 About this manual
Installation
See Unpacking and installing ► 83 and Overview of MADSEN Xeta ► 15 for a full description of unpacking instructions, controls and socket connections.

Safety
This manual contains information and warnings which must be followed to ensure the safe performance of MADSEN Xeta.

Warning • Local government rules and regulations, if applicable, should be followed at all times.

• Standards and safety ► 91
  gives you an overview of device labelling and standards.
• Warning notes ► 92
  contains relevant warning notes.

Training
It is recommended that you read this manual and the OTOsuite User Guide, and make yourself familiar with MADSEN Xeta before you begin testing a patient.

Note • If you are using the OTOsuite Audiometry Module with NOAH, we recommend that you are familiar with the screens and functions provided in NOAH.

Terminology
The correct term for the person being tested/evaluated/serviced may depend on the setting in which the system is being used. For this manual the term “Patient” was chosen, but you may configure OTOsuite to use another term.
1.4 Typographical conventions

The use of Warning, Caution and Note
To draw your attention to information regarding safe and appropriate use of the device or software, the manual uses precautionary statements as follows:

**Warning** • Indicates that there is a risk of death or serious injury to the user or patient.

**Caution** • Indicates that there is a risk of injury to the user or patient or risk of damage to data or the device.

**Note** • Indicates that you should take special notice.

1.4.1 Navigation

Menus, icons and functions to select are shown in bold type, as for instance in:

- Click the Set options icon on the toolbar or select Tools > Options...
2 Getting started

1. If you are using OTOsuite, install OTOsuite from the OTOsuite installation disk. See the OTOsuite Installation Guide.
2. Install MADSEN Xeta as described in Unpacking and installing ► 83.
3. Connect the accessories, Installation ► 83:
   Socket connections - rear panel ► 24 shows the location of the sockets for the various accessories required.
4. Customize your test setup and prepare the test equipment:
   – User-defined tests ► 14
   – Preparing for testing ► 45
5. Switch on MADSEN Xeta. MADSEN Xeta is ready for testing as soon as it is switched on.
6. Launch the OTOsuite Audiometry Module, if required.
7. MADSEN Xeta automatically starts in manual test mode. A new patient record is automatically available and is shown briefly on the display.
   Patients scheduled in the OTOsuite Audiometry Module and not yet tested are indicated by an empty set of parentheses: ( ).
   See Patient data ► 11 for patient handling.
8. You are ready to start testing.
   – Manual air conduction testing
     To perform manual air conduction testing, see Air Conduction threshold test (manual) ► 67.
   – Bone conduction testing
     To perform bone conduction testing, see Bone Conduction threshold test (manual) ► 70.
   – Special tests
     To select other tests such as SISI, see SISI (Short Increment Sensitivity Index) ► 74,
     Stenger, see The Stenger test ► 77,
     Fowler (ABLB), see ABLB (Alternate Binaural Loudness Balance) ► 76.
   Press the function key below the test you wish to perform.
   These tests are optional. To add any of these tests to your configuration, contact your local supplier.
9. To perform automatic testing, press:
   – Auto Threshold for Automatic Threshold testing (Automatic Air Conduction testing ► 12).
   – Auto Screening for Automatic Screening (Automatic Screening ► 13).
10. The tests settings are customised for the individual test types. To change these settings, see MADSEN Xeta Test Settings ► 55.

MADSEN Xeta controls
Front panel controls ► 16
2.1 Patient data

Patients are
- either scheduled and listed in OTOsuite (Scheduled patients) or
- stored in numbered patient records in MADSEN Xeta (Tested patients).

See also Patient record lists ➤ 46.

A. Tested patient records
B. Scheduled patients
2.1.1 Clearing test data
If you want to clear the tests you just made without saving them, press the Clear button and choose Current. You will have to confirm the data deletion.

2.1.2 Viewing results
You can view results for tested patients:
- Press Preview and scroll back and forth using the arrow buttons to select the patient record.
  Already tested patients are indicated by a record number in parenthesis in the lower right corner of the display, e.g. (16).

Example:

Anna Thompson
0531-0198374 (04)

- Use the Left Level knob to scroll through test results.

2.2 Preparing the patient
1. Instruct the patient in using the Patient Response Switch. See The patient responder ► 47.

2.3 Automatic Air Conduction testing

2.3.1 Automatic Threshold testing
The Automatic Threshold test presents tones to the patient at rising and falling levels in relation to the actual patient response.

The test logic adheres to the modified (ascending) Hughson & Westlake method. See Air Conduction threshold test (manual) ► 67 for a description of the method.

1. Select Auto Threshold testing: Press Auto Threshold. The button lights to indicate that you have selected the test.

For symbols used, see Symbols used ► 91.
2. Press **Start** or **Setup**.
   - **Start** to start the test.
     
     If the patient fails to respond to the presented signal, the level is automatically increased until the patient responds to the signal.
     
     The signal is by default presented for each tone in the following order:
     1000 Hz, 2000 Hz, 4000 Hz, and 8000 Hz, followed by 1000 Hz (if Cross Check is enabled), 500 Hz and 250 Hz.
     
     If the patient responds before the signal is presented, the message **Illegal resp.** flashes on the display and the test is paused.

     **Note** • You can use Talk Over at any time during the test. This will pause the test. The test is resumed when you release the Talk Over button.

3. MADSEN Xeta beeps twice and the display shows that the test is completed. The results are stored automatically.

4. If the Masking Assistant flashes M, alternately ?, to indicate that masking may be recommended for specific frequencies, scroll through the frequencies. The audiogram symbol will flash at the specific frequencies where masking may be recommended.

5. To retest any frequencies, see Air Conduction threshold test (manual) ► 67 and, if required, Testing with masking ► 72.

6. If required, select the next patient record (press **Previous/Next**) or press **New Patient**.

2.3.2 Automatic Screening

Screening audiometry is a quick and simple way to identify patients in need of thorough audiological evaluation.

The test involves presenting tones at a predefined Hearing Level, the screening level. The patient is either able or unable to hear the presented tone. The results show whether the Hearing Thresholds are better or worse than the defined screening level.

Screening audiometry can be combined with Threshold determination of the frequencies where the screening level is not audible.

1. Press **Auto Screening**. The button lights to indicate that you have selected the test.

   - **A.** Auto Screening
   - **B.** Current frequency
   - **C.** Starting Hearing Level
   - **D.** Starting ear selected

For symbols used, see Symbols used ► 91.

2. Press **Start** or **Setup**.
   - **Start** to start the test.
– **Setup** to change the specific Auto Screening test settings (see Auto Screening test settings ► 56).

If the patient does not respond to the presented signal, the level is automatically increased until the patient responds to the signal.

The signal is as default presented for each tone in the following order:

- 1000 Hz, 2000 Hz, 4000 Hz, and 8000 Hz, followed by 500 Hz and 250 Hz.

If AS Do AT when AS fails ► 57 is set to to **Yes**, the Auto Threshold test is activated immediately when a frequency fails. The test returns to Auto Screening when a threshold has been determined for the specific frequency. See also Automatic Air Conduction testing ► 12.

### Note

You can use **Talk Over** at any time during the test. This will pause the test. The test is resumed when you release the **Talk Over** button.

3. Xeta beeps twice and the display shows that the test is completed. The results are stored automatically.

4. To retest any frequencies, see Automatic Air Conduction testing ► 12 and Air Conduction threshold test (manual) ► 67.

5. If required, select the next patient record (press **Previous/Next**) or press **New Patient**.

### 2.4 User-defined tests

With MADSEN Xeta you can quickly and easily customize your tests for maximum efficiency.

Make the changes you want in the setup of MADSEN Xeta and save these changes as a specific User Test. See **Setup ► 20**.
3 Overview of MADSEN Xeta

A. Rear panel connections
The rear panel contains the ON/OFF switch, the sockets for connecting various accessories and the socket for power connection. See Socket connections - rear panel ► 24.

B. Display
Settings and the test as it progresses are shown on the display. See Display ► 15.

C. Front panel controls
MADSEN Xeta is operated from the front panel. See Front panel controls ► 16.

3.1 Display

During start-up the display briefly shows information regarding the device type and version, followed by the test screen last used.

The abbreviations used on the display are explained in Abbreviations ► 89.

Top line
During testing the top line in the display shows the intensity numerically in dB HL for the left and right ear.

Ear selection

The ear being tested is indicated with L or R in the display. The display side for L and R can be changed in the settings. See Display ► 61.
Frequency

The selected test frequency for tone testing is shown at the center.

Masking

If masking for the contralateral ear is enabled, this is shown on the opposite side.

Symbols used

<table>
<thead>
<tr>
<th>Left ear Response</th>
<th>Left ear No response</th>
<th>Right ear Response</th>
<th>Right ear No response</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>✗</td>
<td>✗</td>
<td>○</td>
<td>○</td>
<td>Air, unmasked</td>
</tr>
<tr>
<td>□</td>
<td>□</td>
<td>△</td>
<td>△</td>
<td>Air, masked</td>
</tr>
<tr>
<td>&gt;</td>
<td>&gt;</td>
<td>&lt;</td>
<td>&lt;</td>
<td>Bone, mastoid, unmasked</td>
</tr>
<tr>
<td>⊘</td>
<td>⊘</td>
<td>□</td>
<td>□</td>
<td>Bone, mastoid, masked</td>
</tr>
</tbody>
</table>

Other symbols

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>☆</td>
<td>Stored</td>
</tr>
<tr>
<td>a</td>
<td>Automatically tested (preceded by the relevant response symbol)</td>
</tr>
<tr>
<td>fs</td>
<td>Failed screening level (Auto Screening only)</td>
</tr>
<tr>
<td>s</td>
<td>Screening level (preceded by the relevant response symbol)</td>
</tr>
</tbody>
</table>

3.2 Front panel controls

You can access all basic functions directly by using the buttons and knobs on the front panel.

The button light indicators

Each button has its own function. Some buttons have a light to indicate whether the function is currently active or not.
• Press the button to activate.
• Press the button again to deactivate.

### 3.2.1 Front panel layout

The MADSEN Xeta buttons and controls are grouped according to their function and how frequently they are used. The buttons and knobs most frequently used are placed directly below the display.

Beep

If you try to use a button which is not enabled, you will hear two short beeps.

MADSEN Xeta also beeps when an automatic test is completed and when settings are stored.

#### 3.2.2 STIMULUS

**Air**

Selects air conduction (via headset or inserts).

The transducer selected under Setup is displayed as long as the button is pressed. See AC transducer ► 62.
3 Overview of MADSEN Xeta

**Bone**
Selects bone conduction (via bone conductor on mastoid).

**Reverse**
Reverses the function of the Present stimulus button:
- **Active** (indicator lit)
The test signal is presented continuously and the stimulus is interrupted when you press the Present stimulus button.
- **Inactive** (indicator not lit)
The test signal is presented when you press the Present stimulus button.

*Note* • The presentation only applies to the stimulus signal. The masking signal is normally always ON. To change the masking interrupter’s function see Mask. present. ► 60.

**Warble**
Frequency modulates the stimulus signal ±5% at a rate of 5 Hz around the selected frequency.

**Pulsed**
The stimulus signal is presented with a Pulse/Pause ratio of 50%.

**Timed**
The stimulus signal is presented with a preset duration. Does not apply in Reverse mode.

### 3.2.3 MASKING
- By default, you always adjust the stimulus signal level on the Left Level knob, regardless of whether you are testing the right or left ear.
- To adjust the masking intensity use the Right Level knob.
  To change the default setting, see level knob ► 61.

**Contra Air**
Contralateral masking via stereo Air Conductor (headset or insert phones).

**Mono Insert**
Contralateral masking via mono insert phone (for bone conduction test only).

**Level Lock**
Makes the masking level follow the stimulus signal level. You can adjust the difference between the stimulus signal and the masking signal by using the Right Level knob.

### 3.2.4 TEST
Manual Tone testing is active by default.
Auto Threshold
Selects the Automatic Threshold test. For a description, see Automatic Air Conduction testing ► 12.
When activated, the button flashes to indicate that you have selected the test, or that the test has been paused by the user, by faulty responses or by talk-over.

Auto Screening
Selects the Automatic Screening test. For a description, see Automatic Screening ► 13.
When activated, the button flashes to indicate that you have selected the test, or that the test has been paused by the user, by faulty responses or by talk-over.

More (tests)
Press to see the optional test types. Press the desired function key to select.
For a description of the additional tests, see
• SISI (Short Increment Sensitivity Index) ► 74
• The Stenger test ► 77
• ABLB (Alternate Binaural Loudness Balance) ► 76
These tests are optional. To add any of these tests to your configuration, contact your local supplier.

3.2.5 Signal indicators
The indicators are located on either side of the display. They light up when the selected test signal is presented in the corresponding ear.

• Discreet mode
In the Auto Threshold and Auto Screening tests you can change the setting of the signal indicators to Discreet mode, which means that they do not light up when the test signal is presented. If MADSEN Xeta is in view of the patient, this will prevent the patient from knowing when a signal is presented.
This mode also prevents the patient from simulating hearing, because the stimulus level is hidden during the automatic test.

3.2.6 Extended Range
Enables presentation of stimuli above the safety limit (approx. 100 dB). The safety limit is set to 20 dB below the maximum dB HL for a given transducer and frequency.

Note • Automatic testing is always limited to 100 dB HL.

Extended Range has 2 modes (to select, see Extended range ► 61):

• Auto
All levels at all frequencies are always accessible, but the Extended Range button will start flashing when a level above 100 dB HL is reached.

• Manual
The first time extended range above 100 dB HL is reached after patient change or ear change, press the Extended Range button once to allow for access to any level at any frequency with any selected manual test and signal type.
(totally unrestricted after manually confirmed once). If active, the button is lit at lower levels to indicate that it is active, and starts flashing as a warning when entering the extended range.

You can manually deactivate the **Extended Range** button at any time, meaning that you must press it again, if the extended range is reached again.

### 3.2.7 Clear

Deletes patient records:
- Press to clear current or all records.

You will be prompted to select current or all records. Select and confirm your selection.

### 3.2.8 Patient handling buttons

#### New Patient

Selects a new empty patient record. These records are numbered automatically.

See also **Patient record lists ► 46**.

#### Preview

Press to view patient records and test data.

Displays the patient name and ID. If the name is too long, the display will show the first part briefly, then switch to the second part.

If required, press **Change Ear** to view data for the other ear.

See also **Viewing results ► 12** for examples.

#### Scroll Patient List

When MADSEN Xeta is switched on, a new patient record is automatically available.

Scroll through the patient records list. The list may include patients scheduled from the PC.

- **Previous** scrolls through patients already tested.

- **Next** scrolls through scheduled patients.

When you have reached the start or the end of the list, the “New” record will be displayed once more.

See also **Patient data ► 11**.

### 3.2.9 Setup

#### Changing the setup

- **Test-specific settings ► 55**.
- **General settings ► 58**.
Restoring factory default settings
To restore factory default settings:
1. To access the Setup menu of MADSEN Xeta, press Setup.
   When the Setup function is active, the Setup button flashes. Most other buttons are deactivated and you cannot run any tests.
2. Turn the left Level knob to scroll through the parameter list.
3. Select Device settings ➤ 63.
4. Press the Reset function key below the display.
5. Press Setup to exit.

Setting 1 and Setting 2 - customizing tests

Changing the setup
If you select a different function when you have selected a user-defined test, the Setting button will flash to indicate the change.
• To return to your original setting, press the Setting button briefly.
• To add this new function to your setup, press and hold the Setting button until you hear a beep.

Using a user-defined test
1. Press Setting 1 (or Setting 2).
2. You can now perform a test based on the settings selected in Setting 1 (or Setting 2).

Automatic reload of the last used settings
MADSEN Xeta is optimized for testing patient after patient in the same consistent manner. To support this, MADSEN Xeta remembers the settings you used for testing the previous patient, i.e. the settings selected when the first threshold was stored. If Setting 1 or Setting 2 was used, that setting will automatically be reloaded and used for the next patient. Settings are reloaded whenever you select New Patient, change patient using the right or left arrows, and when you switch the power off and back on.
MADSEN Xeta has a third configurable setting. If neither Setting 1 or Setting 2 is selected (you can de-select Setting 1 or Setting 2 by pressing the active Setting button twice) the audiometer uses the third setting. The third setting is defined as the settings present when storing the first threshold for a patient while neither Setting 1 or Setting 2 were selected. The third setting is also remembered and reloaded from patient to patient.

3.2.10 Change Ear (L <-> R)
• Press this button to switch between testing the left and right ear.

Note • Automatic tests automatically switch ear.
3 Overview of MADSEN Xeta

3.2.11 Store/toggle threshold status

Stores a threshold in the internal memory. Thresholds are stored indefinitely (even if the power is switched off), unless you delete them by pressing Clear.

If a previously stored threshold is present, it will be replaced by the new threshold when you press Store.

Toggle threshold status and symbol

- If you press and hold Store, it toggles the threshold status and symbol shown on the display between “threshold value”, “No response” or no symbol. Release the button when it shows the wanted status.

Change frequency after Store

- You can set up the Store button to automatically change the stimulus to the next test frequency.

See AC store: Change freq. ► 59.

When you select a frequency and intensity at which a threshold value has previously been found, this value is shown in the display by means of an "*" symbol beside the frequency indication, and the applicable audiogram symbol beside the level indication, depending on the selection of ear, masking and transducer type.

3.2.12 Response indicator

Lights up when the patient presses the patient responder. You will hear a “beep” at the same time.

See The patient responder ► 47.

3.2.13 Stimulus/masking intensity knobs

Left Level knob

The Left Level knob

- changes the intensity of the test signal in 5 dB steps,
- scrolls between values and functions shown in the display.

Intensity change - stimulus signal

- Changes the intensity for the stimulus signal regardless of whether the signal is being sent to the left or right ear. Turn clockwise to increase the intensity and counter-clockwise to decrease.

To change this setting, see Level knob ► 61.

Masking and intensity

If the masking signal is in locked mode, the intensity of the masking signal is also changed.
3.2.14 Present signal buttons

Left Present Signal button
Presentation of stimulus signal. In normal mode, press to present the stimulus. If Reverse is enabled, press to interrupt the stimulus.

Right Present Signal button
The right Present Signal button usually functions in total parallel with the left Present Signal button.

Controlling the masking signal
Controls the masking signal. See Mask. present. ► 60.

3.2.15 Frequency
The Frequency knob
• changes the frequency,
• scrolls between values and functions shown in the display.

Changing the frequency
Turn clockwise to increase the frequency and counter-clockwise to decrease it.
The selected frequency is shown on the display.

Standard audiometric frequencies
125 Hz, 250 Hz, 500 Hz, 750 Hz, 1000 Hz, 1500 Hz, 2000 Hz, 3000 Hz, 4000 Hz, 6000 Hz, and 8000 Hz.

3.2.16 Talk Over
Enables talk-over via the built-in microphone while the button is pressed.
Automatic testing is temporarily paused during talk over.
Level adjustment
When you press and hold Talk Over, you can adjust the talk over output level in the headphone using the Left or Right Level knob.

The approximate dB HL is shown on the display.

3.2.17 Mic. (microphone)
The internal microphone for Talk Over.

3.2.18 Start/Pause
Press Start/Pause to start, continue or pause a test.
Press the relevant test button to stop the test.

• SISI:
If you have paused the SISI test, press to stop test completely during the pause.

3.3 Socket connections - rear panel

A. AC left
B. BC
C. AC right
D. Masking insert
E. Patient response
F. RS232 interface
G. On/off switch
H. Mains power socket

AC LEFT and AC RIGHT
Connection for the AC transducer to the enclosed headphone. Blue 1/4" jack plug for AC Left and red 1/4" jack plug for right AC Right.

BC
Connection for the black 1/4" jack plug from the bone conductor.
**MONO INSERT**
Connection for the black 1/4" jack plug from the EAR-3A mono insert phone.

**Patient Response switch**
Connection for the black 1/4" jack plug from the patient responder.

**RS 232 interface**
Connection for Xeta to a PC. 9-pole PC-RS232 interface cable.


It is a general rule for all electrical equipment used in the proximity of the patient that:

- The connected equipment must comply with Medical Electrical Systems in IEC 60601-1 3.1 edition: 2012.
- Any PC connected to the Xeta must comply with the requirements of IEC 60950, "Safety of information technology equipment, including electrical business equipment".

**Supply voltage connection**
100-120 V AC, 200-240 V AC, 50/60 Hz, 60 VA
Fuses: 2 T 1 A H/250 V, 5 mm x 20 mm.

**Warning** • Before you replace a fuse, see Fuses ▶ 81.

**Power ON/OFF**
On/Off switch.
4 Navigating in the OTOsuite Audiometry Module

The general functions for navigating in the main window are described in the OTOsuite manual.

Screen descriptions
You will find descriptions of the actual screens and how to use and view them in:

The Tone test screen ➤ 36

4.1 Audiometry Module features

Note • Some of the features below are device-dependent.

With the Audiometry Module, you can
• perform testing while you follow stimulus settings and test progress on your PC display
• view and print test results
• view historic audiometry results from NOAH
• view online audiometry results during testing
• use the Masking Assistant to prompt when masking is recommended
• view the masking level indicator in audiogram
• view audiogram overlays
• enter tester details and test date entry for manually entered audiograms
• enter special test and tuning fork test results
• plan patients for offline testing
• upload test results from offline tests
4.2 The Audiometry Module menu system and toolbar

General icons
See the OTOsuiteUser Guide.

Audiometry icons and menu selections
The icons and menu selections that are unique to Audiometry functionality depend on the test functions included in OTOsuite and/or whether a test device is connected.

4.2.1 File menu

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Audiogram</td>
<td></td>
<td>Select new audiogram. You will be prompted to save or cancel current data.</td>
</tr>
</tbody>
</table>

4.2.2 Edit menu

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Icon</th>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audiometric properties...</td>
<td></td>
<td>Ctrl+U</td>
<td>Click to enter Tester name, Test Date, and air conduction transducer for a manually entered audiogram.</td>
</tr>
</tbody>
</table>

Note • The air conduction transducer is stored when you have selected it in the transducer section of the Control Panel (or with device controls, if applicable) and data points are entered on the audiogram.

4.2.3 View menu

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Masking Assistant</td>
<td></td>
<td>Enable or disable the Masking Assistant.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The Masking Assistant causes an unmasked threshold to flash repeatedly if masking is recommended.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• See The Masking Assistant ► 31.</td>
</tr>
</tbody>
</table>
### Menu item | Icon | Description
--- | --- | ---
Overlays |  | Enables or disables the overlays. Overlays display
- pictures
- severity
- speech banana,
- speech letters,
- unusable area
on the audiogram.
Overlays can also be displayed by selecting them from the overlays box below or next to the audiogram.
To view/hide the overlays box, select **Tools > Options > General**.

Combined Audiogram |  | Click to toggle between viewing both ears in a single audiogram (combined audiogram) or both a left and a right audiogram on your screen.

**Combined View**
- Click to view both ears in a single audiogram.

**Split View**
- Click to view separate audiograms for each ear.

Left - Right |  | Click to display the left ear audiogram on the left side of the window and the right ear audiogram on the right side of the window (when **Dual Graph View** is enabled in **Options > Audiometry > Tone > Misc**).

Right - Left |  | Click to display the right ear audiogram on the left side of the window and the left ear audiogram on the right side of the window (when **Dual Graph View** is enabled in **Options > Audiometry > Tone > Misc**).

Audiogram Legend |  | Click to enable or disable the display of the audiogram legend. The legend contains the most commonly used symbols for the audiogram. It is not configurable.
### 4.2.4 Tools menu

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Curves and Symbols</td>
<td>Click to select the <strong>Curves and Symbols</strong> dialog box. This dialog box and its related function are specific to configuring the curves and symbols to be displayed on the audiogram or speech graph during testing. See Curves and symbols selection ▶️ 39.</td>
</tr>
<tr>
<td>Manage Client List</td>
<td>See description in <em>The client/patient list</em> ▶️ 52.</td>
</tr>
<tr>
<td>Fetch test results</td>
<td>See description in <em>Fetch test results from audiometer</em> ▶️ 52.</td>
</tr>
<tr>
<td>Options...</td>
<td>See description of how to work with user options and User Tests in the OTOsuiteUser Guide.</td>
</tr>
</tbody>
</table>

### Additional icons

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Import Audiometry Data</td>
<td>Click to import audiometry data from AURICAL Plus and MADSEN Conera. See the OTOsuiteUser Guide.</td>
</tr>
</tbody>
</table>
4.3 The Patient Responder indicator

When the patient presses the Patient Responder this is shown on the Stimulus bar, and a sound signal from the PC is heard through the Monitor Speaker or Operator Headset. The sound signal is optional (Tools > Options > Audiometry > General > Measurement, Misc > Audible patient response).

Use the Configuration Wizard to select Single Responder or Dual Responder setup. See Configuring the Audiometry Module ► 79.

<table>
<thead>
<tr>
<th>Single Responder setup</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Green</strong> Indicates that the patient is pressing the Patient Responder.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Dual Responder setup</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Red</strong> Indicates that the patient is pressing the right response button.</td>
</tr>
<tr>
<td><strong>Blue</strong> Indicates that the patient is pressing the left response button.</td>
</tr>
<tr>
<td><strong>Red and blue</strong> Indicates that the patient is pressing both response buttons.</td>
</tr>
</tbody>
</table>

4.4 The Masking Assistant

If the Masking Assistant is enabled, it will at all times check for frequencies that may require testing with masking. This also applies to old audiograms imported from NOAH or XML as long as a supported transducer was stored with the data.

The Masking Assistant is a tool provided to help you with an indication that there may be frequencies where testing with masking\(^1\) is recommended.

---

The audiogram symbol will flash at the specific frequencies where contralateral masking may be recommended.

The masking criteria are configurable so that you can set them up to match your local recommendations for masking. You can for instance choose either frequency specific criteria, which increases the efficacy of your work, or the traditional "one-level-fits-all" criteria.

Select the Tools > Configuration Wizard > Configure... Audiology > Masking Assistant to set up the masking criteria.

How does the Masking Assistant work?

### Terminology

| AC   | AC test ear |
| ACc  | AC contra   |
| BC   | BC           |
| BCc  | BC contra    |
| Min IA | Minimum inter-aural attenuation. |

### When is masking required?

Masking is recommended when the following conditions are met:

- AC > ACc + Min IA
- or
- AC > BCc + Min IA
- BC < AC - x* dB

Only stored thresholds measured without masking are checked. Levels which did not evoke a response are excluded from the check. This means that as soon as a masked threshold has been stored, the flashing stops for that frequency.

* denotes configurable Air/Bone gap criterion (Tools > Configuration Wizard > Configure... Audiology > Masking Assistant).

---

**Min IA is frequency specific**

These are the Min IA tables for TDH-39 and Otometrics Inserts used in the Masking Assistant.

**Min IA (supraural phone: TDH-39), frequency specific**

<table>
<thead>
<tr>
<th>Hz</th>
<th>dB</th>
<th>Source</th>
</tr>
</thead>
<tbody>
<tr>
<td>250</td>
<td>48</td>
<td>Munro &amp; Agnew, BJA (1999)</td>
</tr>
<tr>
<td>500</td>
<td>44</td>
<td>Munro &amp; Agnew, BJA (1999)</td>
</tr>
<tr>
<td>750</td>
<td>40</td>
<td>N/A - fulfill traditional approach</td>
</tr>
<tr>
<td>1000</td>
<td>48</td>
<td>Munro &amp; Agnew, BJA (1999)</td>
</tr>
<tr>
<td>1500</td>
<td>40</td>
<td>N/A - fulfill traditional approach</td>
</tr>
<tr>
<td>2000</td>
<td>44</td>
<td>Munro &amp; Agnew, BJA (1999)</td>
</tr>
<tr>
<td>4000</td>
<td>50</td>
<td>Katz J / Munro &amp; Agnew, BJA (1999)</td>
</tr>
<tr>
<td>6000</td>
<td>44</td>
<td>Hall J.W. III &amp; Mueller G.H. III / Munro &amp; Agnew, BJA (1999)</td>
</tr>
<tr>
<td>8000</td>
<td>42</td>
<td>Katz J / Munro &amp; Agnew, BJA (1999)</td>
</tr>
</tbody>
</table>

**Min IA insert phone**

<table>
<thead>
<tr>
<th>Hz</th>
<th>dB</th>
<th>Source</th>
</tr>
</thead>
<tbody>
<tr>
<td>125</td>
<td>60</td>
<td>N/A - traditional value</td>
</tr>
<tr>
<td>250</td>
<td>72</td>
<td>Munro &amp; Agnew, BJA (1999)</td>
</tr>
<tr>
<td>500</td>
<td>64</td>
<td>Munro &amp; Agnew, BJA (1999)</td>
</tr>
<tr>
<td>750</td>
<td>60</td>
<td>N/A - traditional value</td>
</tr>
<tr>
<td>1000</td>
<td>58</td>
<td>Munro &amp; Agnew, BJA (1999)</td>
</tr>
<tr>
<td>1500</td>
<td>60</td>
<td>N/A - traditional value</td>
</tr>
<tr>
<td>2000</td>
<td>56</td>
<td>Munro &amp; Agnew, BJA (1999)</td>
</tr>
<tr>
<td>3000</td>
<td>58</td>
<td>Munro &amp; Agnew, BJA (1999)</td>
</tr>
<tr>
<td>4000</td>
<td>72</td>
<td>Munro &amp; Agnew, BJA (1999)</td>
</tr>
<tr>
<td>6000</td>
<td>54</td>
<td>Munro &amp; Agnew, BJA (1999)</td>
</tr>
</tbody>
</table>

4.5 The Audiometry Module Control Panel

Click the **Control Panel** icon in the toolbar to activate the Control Panel.

*Note • The appearance of the Control Panel depends on the test device used.*

The general function of the Control Panel is described in the **OTOsuite User Guide**. The Audiometry Module Control Panel shows the settings selected on the connected audiometer for the specific test.

![Control Panel](image)

**Fig. 1** The MADSEN Xeta Control Panel

4.5.1 The Control Panel

When you activate the **OTOsuite Audiometry Control Panel**, MADSSEN Xeta automatically connects to the audiometer.

*Note • You cannot operate MADSSEN Xeta from the Control Panel.*

The Control Panel is divided into a number of sections where you can view various settings, and a section for controlling communication with the audiometer.
The Stimulus panel shows the stimulus type used and the selected test ear.

The Masking panel shows the masking used and the selected test ear.

The Test panel shows the test type used.

**Note**: If there is a risk that patient selected in the audiometer does not correspond with the patient shown in OTOsuite or NOAH status bar, a warning triangle will be shown on the screen.

- Make sure that you select the correct patient, either in the audiometer or in OTOsuite.

### 4.6 The stimulus bar

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
</tr>
</thead>
<tbody>
<tr>
<td>50 dB</td>
<td>1000 Hz</td>
<td>[ 20 dB ]</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Intensity</td>
<td>Stimulus indicator</td>
<td>Transducer indicator</td>
<td>Stimulus being presented</td>
<td>Frequency</td>
<td>Stimulus bar color</td>
<td>Routing indicator</td>
<td>Masking on</td>
</tr>
</tbody>
</table>

Otometrics - MADSEN Xeta
Intensity

Indicated by the dB level above the channel status bars.
- Masking is denoted by square brackets around the level (calibrated in effective masking level).
- The green triple wave symbol above the level indicates that the stimulus is currently being presented.

Stimulus bar color

Indicates the routing for each channel:
- Blue = left ear
- Red = right ear
- Blue/Red = binaural
- Gray = unspecified

Stimulus, transducer and routing indicators

The stimulus/masking type, the transducer and the routing for each channel.

<table>
<thead>
<tr>
<th>4.6.1 The Tone stimulus bar</th>
</tr>
</thead>
</table>

During online testing, the stimulus bar shows:

Symbol

- Indicates the symbol that will be displayed on the audiogram(s) when a data point is stored. The symbol shown reflects the current audiometer measurement settings.

See also Curves and symbols selection ► 39.

Frequency

- Indicated by the Hz value in the center of the stimulus bar.

4.7 The Tone test screen

During online testing, the screen reflects the test done by the audiometer as it progresses.
4.7.1 The work area in the Tone screen
The Tone test work area consists of a range of elements for viewing and selecting various features:

- **The audiogram** ► 37
  With a description of audiogram elements, how to view single or dual graphs, and how to view the intensity levels used for masking.

- **The Legend box** ► 41
  With a description of result boxes for special tests, utilities such as a timer and an overlays selector, and instructions for how to view/hide the feature boxes.

4.7.2 The audiogram

**Audiogram elements**

<table>
<thead>
<tr>
<th>Cross hatch</th>
<th>Indicates your current stimulus level and frequency. The color indicates the routing:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Blue = left</td>
</tr>
<tr>
<td></td>
<td>• Red = right</td>
</tr>
<tr>
<td></td>
<td>• Black = binaural</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Mouse cursor</th>
<th>Indicates where you place the mouse. The color indicates the routing:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Blue = left</td>
</tr>
<tr>
<td></td>
<td>• Red = right</td>
</tr>
<tr>
<td></td>
<td>• Black = binaural</td>
</tr>
</tbody>
</table>
Audiogram

- Intensity is shown to the left of the audiogram in dB HL.
- Octave frequencies are shown below the audiogram in Hz.
- Interoctave frequencies are shown above the audiogram in Hz.

Viewing the audiogram

You can choose between:

Single graph view

A. Stimulus marker (ear color)
B. Masking level indicator
C. Mouse cursor (ear color)

Dual graph view

When you use the dual graph viewing option, the graph that corresponds with the stimulus ear will have a gray outline to denote the active audiogram.

You can switch the position of the right and left graphs to correspond to your viewing preference.

1. Select Tools > Options > Tone > Misc. > Dual Graph View or in the menu bar under View.

A. Stimulus marker (ear color)
B. Masking level indicator
Viewing masking levels

**Masking levels**

Below the audiogram, the intensity levels used for masking can be displayed. It is an option to display the masking levels. Select **Tools > Options > Tone > View > Misc. > Masking Levels**.

- In combined view, the non-test ear masking levels are shown below the graph.

- In Dual Graph View, the masking level used for masking the non-test ear is by default displayed under the graph for the test ear. The masking level can be set to be displayed either under the test ear or under the non-test ear: select **Tools > Options > Tone > View > Misc > Masking Table Placement**.

### 4.7.3 Curves and symbols selection

You can select a symbol and/or a curve style for a specific measurement and you can create new symbols.

#### 4.7.3.1 Selecting a symbol or curve

You can select a symbol and/or a curve style for a specific measurement.

1. Select **Tools > Curves and Symbols...**
2. Click on the selections that apply to your measurement under **Test, Transducer, and Aided Condition**. The current symbols and line style are shown.
3. Double-click on the symbol you wish to change. The **Symbols** selection dialog box is shown.
4. Double-click on the symbol you wish to use.
5. To change the line style of the curve, select from the **Line Style** drop-down list.
6. To change the color, double-click on the current **Color** square. Select a new color or click on **Define custom colors** to select a color not shown. Click **OK**.
7. To optimize viewing of the audiogram, you can offset the symbols in relation to the audiogram grid in the fields **Horizontal Offset** and **Vertical Offset**.
You can superimpose symbols on the audiogram where two different points share the same value (i.e. air and bone threshold). In order to see both superimposed symbols, you can define an offset direction for each individual symbol.

4.7.3.2 Creating new symbols

1. Use Microsoft Powerpoint to create graphics that can be saved in Enhanced Meta Files (*.emf) format.
2. The outer size of the EMF file must be less than or equal to 1 x 1 inches (2.5 x 2.5 cm).

   **Note** • If the symbols are created larger, this may severely compromise the performance of OTOsuite.

The standard symbols are drawn within a centered inner frame of 1.5 x 1.5 cm (0.6 x 0.6 inches). The area between the inner and outer frames is used for additions to the main symbol, such as arrows for No Response or Response at Limit, and designators for Aided Left or Aided Right.

3. Before you store the new graphic, make sure that the outer and inner frames are invisible: Select the frame, and set the line color to No Line. Repeat this for each frame.
4. To save as an *.emf graphics file, select all elements in the drawing (including the invisible outer frame as well as the symbol itself centered within the frame). Right-click and select Save as picture...
5. Name the file and select the file type *.emf.
6. Save it in C:\Program Files\GN Otometrics\OTOsuite\AudSymbols.
7. Launch the OTOsuite Audiometry Module and select Tools > Curves and Symbols.

   The new symbol should appear on the list of symbol options.

   In this dialog box, you also have options for setting the color, line type, and horizontal and vertical offsets that will apply when you use the new symbol.
4.7.4 Compare audiograms

Make sure the feature box for Compare Audiograms is visible in the OTO-suite main view area (if not, set Tools > Options > Tone > View > Show Compare Audiograms to On).

OTOsuite under NOAH

All sessions relating to the selected client, and containing audiometry data are automatically loaded into the Compare Audiograms feature box.

Compare current and historical audiograms

1. In the Compare Audiograms feature box, single-click to select the audiograms you wish to view from the list of historical audiograms. Any selected historical audiogram will appear with grey curves in the audiogram graph.

2. All curves of the selected audiograms are viewed and compared simultaneously unless you explicitly select a curve type from the feature box drop-down lists. The lists let you define the test type and aided condition that you wish to view and compare.

3. You can enhance the compare view by enabling the Difference view. This is done by checking the Difference option in the feature box. The Difference view highlights any difference between the most recent and any older audiogram curves selected in the list.

4. If you decide to make a new audiogram, then a new Current audiogram is generated in the Compare Audiograms feature box list, and what was previously the current audiogram consequently becomes a historical one, displayed with measurement date.

5. If you deselect the viewing of a Current audiogram so that it is no longer shown, then it will instantly be reselected if you try to edit a curve.

6. You can keep any previously collected audiogram visible in the graph while collecting the current audiogram simply by keeping it selected in the Compare Audiograms feature box while measuring.

4.7.5 The Legend box

The Legend box shows the audiogram symbols used in the graphs.

4.7.6 Tone view options

You can access a number of Tone view options directly from the Tone main screen.

The view options can be turned on/off. To do so, select Tools > Options > Tone.
## Overlays

<table>
<thead>
<tr>
<th>Overlays</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pictures</td>
<td>Displays pictures representing common environmental sounds at their approximate dB level (e.g. bird, plane).</td>
</tr>
<tr>
<td>Severity</td>
<td>Displays the audiometric severity levels (normal, mild, moderate, moderate-to-severe, severe, profound).</td>
</tr>
<tr>
<td>Speech Banana</td>
<td>Displays the speech banana of a listener with normal hearing.</td>
</tr>
<tr>
<td>Speech Letters</td>
<td>Displays speech sounds at their approximate dB level.</td>
</tr>
<tr>
<td>Unusable area</td>
<td>Shades the area which is outside the patient's dynamic range of hearing.</td>
</tr>
</tbody>
</table>

Select the overlay to be displayed on the audiogram.

These overlays assist in the counseling process.

- Select **Tools > Options > Audiometry > Tone > Overlay Selection Box**.

The overlay options are:
4.8  Work-flow related features

4.8.1  Selecting orientation
Select graph, table and control layout

Click **Select Orientation** on the toolbar to see the following dialog:

<table>
<thead>
<tr>
<th>Graphs and Tables</th>
<th>Click to select the way you view the patient in relation to your monitor.</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Graphs and Tables" /></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Control</th>
<th>Click to select the position of the stimulus channel on the screen.</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image2.png" alt="Control" /></td>
<td></td>
</tr>
</tbody>
</table>

4.8.2  Ear shift frequency and level setting
When you change test ear, you can define that the frequency and level should be set to 1000 Hz at 20 dB HL. To do so, select **Tools > Options > Tone > Measurement > Ear Shift Frequency and Level**. Check **Ear Shift Frequency and Level**.
4 Navigating in the OTOsuite Audiometry Module
5 Preparing for testing

It is important to prepare properly before making measurements with MADSEN Xeta and the OTOsuite software. It is timesaving for both you and the client if the environment, the client, the test device, and the software are ready for the test.

5.1 Preparing the test environment

Before you start testing, make sure that the test environment is conducive to testing.

- The test environment should be quiet, preferably in a sound proof booth, for accurate threshold results.
- The test room or sound booth should have a minimum of furniture and hard surfaced articles (i.e. filing cabinets, tables etc), as these can cause reverberation during sound field testing. Live voice examinations are best carried out when using a sound booth, so that the client/patient cannot hear the tester’s voice directly. With tester and client/patient in the same room, especially of clients with normal or almost normal hearing, false results could be obtained.

Furniture

The test environment should include

- a comfortable chair for the client,
- a child-sized chair if testing pediatrics,
- a comfortable chair for the assistant.

The examiner should be able to see the client/patient. The client/patient should be seated so that it is not possible to see what the examiner is doing or how the equipment is being operated. This reduces the likelihood that the client/patient can anticipate when the stimulus will be presented.

For pediatric testing consider using a highchair, which is a familiar environment for most children and will place them closer to eye level with the visual reinforcement toys. Make sure if performing visual reinforcement audiometry that the reinforcing toys can be seen by the child. A child cannot look over and up at a toy until approximately 9 months of age.

Lighting

The lighting in the booth should be bright enough for the examiner to adequately see the client.

Toys

If testing pediatrics, several interesting toys are needed to center the child (obtain the child’s attention toward the assistant or tester) prior to stimulus presentation. It is best if these toys do not produce sounds.

The child should be conditioned to respond to the sound of the stimulus only. Competing sounds from toys can confuse the child and reduce the reliability of the test.

Soft toys are needed to keep a young child’s attention during behavioral observation or visual reinforcement audiometry. Younger children like to tap the toy on the highchair tray and therefore a toy that does not create much sound would be more appropriate during testing.

Blocks, buckets, puzzles are needed to keep a child’s attention during play audiometry.

5.2 Preparing the test equipment

Make sure that you have connected the required accessories:

- insert phone(s). To connect, see Air conduction ► 84.
- bone conductor. To connect, see Bone conduction ► 85.
- patient responder (Socket connections - rear panel ► 24).
5.2.1 Connecting the cables of the test equipment

Connect the cabling of the computer and various accessories as shown in the following illustrations.

**USB/RS232 connection**

For PC or Laptop with USB port or RS232 cable for PC or Laptop with serial port.

A. Patient responder

5.2.2 Patient record lists

Patient records are stored in one of two lists:

- **Scheduled patients**
  List downloaded from OTOsuite.
  Scheduled patients not yet tested are indicated by an empty set of parentheses: ( ).
  These records hold no test data or list number, only patient name and ID.
  When you have saved test data for that particular patient, the patient record is moved to the Tested patients list. The record will now show a list number in the lower right corner of the display.

- **Tested patients (scheduled and unscheduled)**
  Consists of records from scheduled and tested patients, and records created by pressing New patient and storing test data.
  These records hold patient name and ID, as well as test data and list number.

**Switching to the next patient**

When you have tested a patient and saved patient data, switch to the next patient by pressing Next or New Patient. The display will indicate ‘- New’ or the name of the next scheduled patient.
Creating a new patient

- Press **New Patient** to create a new patient record in MADSEN Xeta. This applies to unscheduled patients.
  These records hold no patient name, ID or test data. Only the list number.

A. Patient records
B. Scheduled patients

- When you test the patient, the test data will be stored in a numbered patient record.

5.2.3 The patient responder

- Place the patient in a sound booth, if one is available, and facing away from MADSEN Xeta.
- Instruct the patient in how to use the patient responder.
- Instruct the patient in pressing the button even if only weak signals are heard.

**Note** • During automatic testing, if the patient presses the switch repeatedly during a stimulus presentation, the response is ignored.

**Note** • During automatic testing, if the patient does not release the switch, a beep is issued in the headphones. If this situation is repeated, the test is paused. Reinstruct the patient.

- Before testing, check that the **Response** indicator lights up when the patient presses the responder.

5.2.4 Preparing for air conduction testing

**Fitting on patient**

- Fit the headphones on the patient, with the red phone on the right ear.
- Choose the ear with the better hearing to be tested first.

**Instructing the patient**

- The patient will be hearing brief tones.
• The tones may at times appear to be very weak.
• Instruct the patient in how to use the patient responder (The patient responder ► 47).
• The patient should press the patient responder as soon as the tone is heard, even if it is very weak.

5.2.5 Preparing for bone conduction testing

Make sure that the bone conductor is properly connected.

Fitting the bone conductor on the patient

When you fit the bone conductor on the patient:
• Instruct the patient in what you are about to do.

<table>
<thead>
<tr>
<th>Note • The bone conductor cable and insert phone cable must not be removed or tampered with while MADSEN Xeta is powered on. Either disconnect the bone conductor or insert phone entirely from the instrument, or make sure that the instrument itself is disconnected from the power source.</th>
</tr>
</thead>
</table>

• If a sound booth is not available, place the patient facing away from MADSEN Xeta. This is to avoid visual clues during testing.
• If applicable, set the switch on the Talk Back microphone to ON and set the level of Talk Back.
• Position the bone conductor/vibrator so that it rests comfortably against the mastoid bone (behind the ear) and is not in contact with the pinna, or against the patient’s forehead.
• If MADSEN Xeta is calibrated for this, see BC transducer ► 62 to choose between Forehead and Mastoid, depending on the preferred placement of the bone conductor.

Testing with masking

If you intend to use masking, either use the mono insert phone (recommended) or fit the headphones so that the red (right) phone is applied to the poorer ear for masking, and the other phone is applied to the patient’s temple region, leaving the test ear uncovered.

<table>
<thead>
<tr>
<th>Important • The masking transducer must not under any circumstances block or cover the bone conduction test ear. If it does, this will invalidate the test due to the occlusion effect.</th>
</tr>
</thead>
</table>

Make sure that there is no contact between the headband, which holds the bone conductor in place, and the headset or headband supporting the headphones. This will prevent vibrations from being conducted from one to the other. Leave it in this position until the test is finished.

Instructing the patient

• The patient will be hearing brief tones.
• The tones may at times appear to be very weak.
• The tones can be heard either in the one ear, in the other ear or in both ears simultaneously.
• Instruct the patient in how to use the patient responder.
• The patient should press the patient responder as soon as the tone is heard, even if it is very weak.
• You may prefer that the patient indicates in which ear the tone was heard by raising a hand.
• The patient should not touch or move the bone conductor from its position.
5.2.6 Preparing for testing with masking

See Air conduction with masking - suggested procedure ►72 for a recommended procedure on testing with masking.

When to use masking for Air Conduction testing

If the difference between the thresholds in the two ears is 40 dB or greater, it is recommended that you test the poorer ear again with masking applied to the better ear. See Testing with masking ►72.

If the appliance of masking is to be optimally administered without using unnecessary masking, it is recommended in the literature not to use the one-number-fits-all 40 dB criterion for circum-aural and 55 to 60 dB criterion for insert phones. This may cause errors, and will increase the test time, as well as increase the strain on the patient. Instead, the literature recommends the use of frequency specific criteria that would be taken from transducer specific inter-aural attenuation tables available from clinical studies.¹

Use the Masking Assistant for easy application of this method.

When to use masking for Bone Conduction testing

If the difference between the air conducted threshold and the unmasked bone conduction threshold of the same ear is 15 dB or greater, it is recommended that you retest bone conduction thresholds with masking applied to the contralateral ear. See Testing with masking ►72.

When to use a mono insert phone

Masking via insert phone is recommended. The mono insert phone gives less inter-aural cross talk than the TDH39 headphones.

The test procedure is similar to that described in Bone conduction with masking - suggested procedure ►73.

Instructing the patient

• In addition to the tones in the test ear, the patient will be hearing a noise in the other ear.
• The tones can be heard in either ear.
• The patient should respond to the tones in the test ear and ignore the noise.
• The patient should press the patient responder as soon as the tone is heard.
• You may prefer that the patient raises a hand to indicate in which ear the tone was heard. This is particularly relevant since masked testing is used to determine that the signal is perceived by the test ear.

5.3 Listening check

Perform listening checks routinely to make sure that the equipment is functioning properly.

• Use a person who has auditory thresholds below 10 dB and make sure that he or she can hear a very faint sound for each stimulus type, frequency and for each transducer at 0 to 5 dB.
• If the person cannot hear the stimulus, contact the manufacturer or local representative to troubleshoot the system.
• It is recommended that the system be calibrated annually or according to the local requirements.

5.4 Preparing the client

5.4.1 Hygienic precautions
It is important that hygienic precautions are taken to protect the client from cross-infection. Be sure to follow any established infection control procedures for the setting in which you are working.

- **Headphones**
  Clean the headphones between patients, e.g. with a non-alcohol based antibacterial wipe, such as Audiowipes.

- **Insert earphones**

  **Warning** To prevent cross-infection, use new eartips when you test the next client.

5.4.2 Inspecting the client’s ear(s)
1. Position the client so that you can easily access the client’s ear(s).
2. Grasp the pinna and gently pull it back and slightly up and away from the client’s head.
3. Inspect the ear canal and make sure that you can see the ear drum.
   If you can see apparent narrowing of the ear canal, it may be blocked by vernix or debris, or it may not be straight.
4. If the ear canal is blocked, for instance by vernix or debris, the outcome of the procedures may be affected.
   Clean the ear canal if required.

5.5 Preparing the Audiometry Module for testing

**MADSEN Xeta and the Audiometry Module**
- Make sure the cables of the test equipment are connected correctly.
- Launch OTOsuite and the Audiometry Module on the PC (see the OTOsuite User Manual).
- Make sure MADSEN Xeta is switched on.
- Make sure the connection between the Audiometry Module and MADSEN Xeta is enabled.

**Scheduling patients**
- If you wish to schedule your patients and transfer the list to the audiometer if your audiometer supports this function, see The client/patient list ▶ 52.

**Fetch multiple test results**
- If you have done off-line testing with MADSEN Xeta, you can fetch test results from the audiometer.
  See Fetch test results from audiometer ▶ 52.

5.6 Proper transducer placement

**Headphones**
1. Loosen the headband and place both the left and right side of the headphones simultaneously.
2. Make sure that the blue indicator is on the left ear and the red indicator is on the right ear. The center of the headphone diaphragm should be directly opposite the opening of the ear canal for the left and right side.

Note • If the headphones are not placed properly, there is risk of causing the ear canal to collapse which will result in elevated thresholds.

3. Ask the patient if the headphones are comfortable.
4. Tighten the headband while holding the headphones in place with your thumbs.
5. Examine the placement of the headphones to make sure they are level, and properly positioned.

Insert Earphones
Young children tolerate insert earphones better than headphones.
The insert earphones are color-coded:
• the blue indicator for the left ear,
• the red indicator for the right ear.

1. Select the largest foam eartip that will fit into the patient's ear.
   If the eartip is too small the sound will leak out and the dB level will not be accurate at the eardrum.
   Insert earphones have greater attenuation between ears especially at the low frequencies; this reduces the need for masking.

2. It is best to clip the insert earphone transducers behind the child or on the back of their clothing and then fit the foam eartip into the child's ears.
   If the foam eartip is a little too large, consider cutting it down to make it a little smaller.

Bone Oscillator

Note • For unmasked bone thresholds, you can store binaural data by selecting Binaural bone in the routing section of the control panel.

Mastoid placement
1. Move any hair covering the mastoid out of the way and place the flat round part of the bone oscillator securely on the boniest portion of the mastoid without any part of the transducer touching the external ear.
2. Make sure the bone oscillator is tight on the mastoid but still comfortable.
3. If you are going to perform masking with earphones, position the other end of the bone oscillator headband over the patient's temple on the opposite side of the head so that the headband of the earphones and bone oscillator fit on the patient's head.
5.7 The client/patient list

**Note** • You can set up OTOsuite to use the term client or patient according to your preferences. Use the Configuration Wizard to do so: Tools > Configuration Wizard...

In the OTOsuite Audiometry Module you can

- Create patients for the scheduled patient list.
- Edit patient data.
- Transfer the list to the audiometer, where you can view and select the individual patient records for testing.
- Remove patient records from the list.

5.7.1 Create patients for the patient list

1. Select Tools > Manage patient list.
2. Click Add to add new patients to the list. The Client Details dialog appears.
3. Enter the client details (see also Select/create a client in OTOsuite in the OTOsuite User Manual and click OK.

**Edit patient data**

1. Select Tools > Set up patient list.
2. Click Edit to edit client details.
3. If you change the value of the Identifier field, a new client record is created.
4. Click OK to exit the Client Details dialog.
5. Click Next to transfer your changes to the audiometer.
6. Click Finish.

**Remove patient records**

1. Select Tools > Manage patient list.
2. Click on the patient record you wish to remove from the list.
3. Click Edit to edit client details.

5.7.2 Transfer the patient list to the audiometer

1. Select Tools > Manage patient list.
2. In the Manage Patient List screen click Next to transfer the patient list to the audiometer.
3. Click Finish.

5.8 Fetch test results from audiometer

To transfer test results from your audiometer to the OTOsuite Audiometry Module:

1. Switch on the audiometer.
2. In the OTOsuite Audiometry Module select Tools > Fetch Test Results...

Follow the on-screen instructions.
5.9 Preparing the patient for testing

If the patient has been exposed to high levels of sound, this may create a temporary threshold shift (TTS), which will diminish with time. If the patient is tested soon after this type of noise exposure, it may not be possible to determine the normal hearing threshold. It is recommended that a minimum of 16 hours should pass between exposure and testing.

Explaining the test procedure

• Explain how the test will be done, including which ear will be tested first.
• Describe what the presented signals may sound like.
• Explain what the patient will be expected to do. This includes using the patient responder and responding to the presented signals.
Preparing for testing
6 MADSEN Xeta Test Settings

MADSEN Xeta is supplied with factory default settings. These settings have been selected as those most likely to be used in the specific test functions. The settings are either test-specific, or apply to the general functions of MADSEN Xeta.

The system saves a copy of the test settings as 'system test settings' the first time a stimulus is presented to a new patient. They are also part of the settings saved when a user setting is stored.

The system test settings will be used at power up or, if no user setting is activated, when a new patient is chosen.

If a user setting is chosen the test settings associated with that user is used when a new patient is chosen.

When you switch to a new test, the settings used in the test you are leaving will be saved and reused when you return to that test.

The default settings can be loaded from Device settings ► 63.

Test setting types

You can change the settings of MADSEN Xeta in three ways:

- Front panel controls ► 16
- Test-specific settings ► 55
- General settings ► 58

All changes made to the test specific and general settings are permanent and will be used the next time you switch on MADSEN Xeta.

6.1 Test-specific settings

When you select a specific test, you can change a number of settings relating specifically to this test.

1. Select the specific test, for example AT, and press Setup to change settings.

2. Use the Left Level knob to scroll between test settings.

3. Use the Right Level knob to scroll between setting values.

4. Use the Frequency knob to scroll between frequency settings.

5. Press Setup to leave the Setup function.

6. The settings are saved and will be used when next you use this test.

6.1.1 Auto Threshold test settings

This Automatic Threshold test adheres to the modified (ascending) Hughson & Westlake method.

- To speed up the test progress, see the setting AT Procedure ► 56.
- To change settings, press Setup.
- To return to the Auto Threshold test, see Automatic Air Conduction testing ► 12.

Default starting frequency

<table>
<thead>
<tr>
<th>Default starting frequency</th>
<th>1000 Hz. You cannot change this value.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>If the test cannot determine a threshold at this starting frequency, the entire test is aborted. Reinstruct the patient and try again.</td>
</tr>
</tbody>
</table>
## AT Frequencies
- Use the **Frequency** knob to scroll between frequencies.
- Use the **Right Level** knob to set to **On** or **Off**. 1000 Hz is always **On** and cannot be changed.

## AT Start Level
Use the **Right Level** knob to change the starting hearing level.

Min. 20 dB, max. 60 dB HL.

## AT Max Level
Max HL is the highest stimulus level that may be presented (50 to 80 dB HL or Max dB).

If you select the value **Max dB**, the maximum level presented will be the safety limit for that frequency (approx. 100 dB). See **Extended Range ▶ 19**.

## AT Criterion
This setting defines the number of threshold passages that determines the threshold.

Use the **Right Level** knob to set the threshold detection criterion to:
- 1 of 1
- 2 of 3, or
- 3 of 5

## AT Cross check (at 1000 Hz)
Use the **Right Level** knob to select/deselect cross check.

- **Yes**
  The 1000 Hz threshold will be retested before testing the lower frequencies.

- **No**
  The 1000 Hz threshold will not be retested before testing the lower frequencies.

The cross check function is a quick test of the levels next to the 1000 Hz threshold. If the 1000 Hz cross check fails, a new full threshold test is made for this frequency.

## AT Procedure
- **Standard**
  The stimulus but not the preset stimulus duration is interrupted by the patient response. This is followed by a random inter-stimulus interval.

- **Quick**
  Both the stimulus and the preset stimulus duration are interrupted by the patient response. The response is immediately followed by the random inter-stimulus interval. This results in a faster test.

## AT Discreet mode
- **On**
  The Signal indicator does not light up and Xeta does not sound a beep when stimulus is presented and the stimulus levels are not displayed.

- **Off**
  The stimulus level is displayed and the signal indicator lights up when stimulus is presented.

### 6.1.2 Auto Screening test settings
- To change settings, press **Setup**
To return to the Auto Screening test, see Automatic Screening ► 13.

<table>
<thead>
<tr>
<th>Default starting frequency</th>
<th>1000 Hz. You cannot change this value. If this frequency is not successfully tested, the entire test is aborted. Reinstruct the patient and try again.</th>
</tr>
</thead>
</table>
| AS Frequencies            | • Use the Frequency knob to scroll between frequencies.  
                             • Use the Right Level knob to set to On or Off. 1000 Hz is always On and cannot be changed. |
| AS Familiarize            | Use the Right Level knob to select.  
                             At the start of each frequency a clearly audible tone is presented as an example of the presented signal. During the actual test, the signal to be presented is reduced to the predetermined screening level.  
                             Default: 40 dB HL  
                             Range: 40 dB to 60 dB HL or Off |
| AS Method                 | This setting defines the number of threshold passages that determines the threshold.  
                             Use the Right Level knob to set the threshold detection criterion to:  
                             1 of 1, or  
                             2 of 3 |
| AS Level                  | Use the Right Level knob to change the starting hearing level.  
                             Min. 0 dB, max. 40 dB HL. |
| AS Do AT when AS fails    | Use the Right Level knob to select/deselect.  
                             • On  
                             To include Auto Threshold in the Auto Screening test.  
                             The Auto Threshold test is activated immediately when a frequency fails. The test returns to Auto Screening when a threshold has been determined for the specific frequency.  
                             • Off |
| AS AT Criterion           | This setting defines the number of threshold passages that determines the threshold. This applies when Auto Threshold is used as a complimentary function at frequencies where the screening fails. See also the setting AS Do AT when AS fails ► 57, to include Auto Threshold in your Auto Screening test.  
                             Use the Right Level knob to set the threshold detection criterion to:  
                             1 of 1  
                             2 of 3, or  
                             3 of 5 |
### 6.2 General settings

These settings apply to all test functions. However, some settings do not apply in automatic testing.

**Changing general settings**

1. To access the Setup menu of Xeta, press **Setup**.
   
   When the **Setup** function is active, the **Setup** button flashes. Most other buttons are deactivated and you cannot run any tests.

2. Turn the **Left Level** knob to scroll through the parameter list.
   
   As a rule, the top line in the display contains a description of the current parameter, for instance:

   **AC TRANSDUCER**

   The bottom line contains the value that you can change.

3. To change the setting, for most items, use the **Right Level** knob.

4. Changes made under **Setup** will be saved when you leave **Setup**, and will apply the next time you switch on Xeta.

5. The most recently selected item will also be the one displayed the next time you activate **Setup**.

6. To exit this function press **Setup**.

**6.2.1 Return to default settings**

To return to the default settings, see **Setup** ➔ 20.
6.3 Items in the Setup menu

Select manual AC frequency

<table>
<thead>
<tr>
<th>AC manual freqs.</th>
<th>Here you can select (ON) or cancel (OFF) the frequencies to be included in manual audiometry tests. The frequencies are selected using the Frequency knob. ON/OFF is selected using the Right Level knob.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default ON:</td>
<td>250, 500, 1000, 2000, 3000, 4000, 6000, 8000</td>
</tr>
</tbody>
</table>

AC Store: Change

<table>
<thead>
<tr>
<th>AC store: Change freq.</th>
<th>Method for frequency change when you press Store. Xeta will automatically test frequencies above 1000 Hz in ascending order, and frequencies below 1000 Hz in descending order.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default:</td>
<td>Butterfly</td>
</tr>
<tr>
<td>NO CHANGE</td>
<td>If this parameter is set to “No change”, the setting will remain at the current frequency when you press Store (the frequency remains the same).</td>
</tr>
<tr>
<td>WRAP</td>
<td>If you press Store at the highest possible frequency, you switch to the lowest possible frequency. At other frequencies, pressing Store advances the frequency.</td>
</tr>
<tr>
<td>BUTTERFLY</td>
<td>If you press Store at the highest or the lowest possible frequency, you change to 1000 Hz.</td>
</tr>
</tbody>
</table>

Select manual BC frequency

<table>
<thead>
<tr>
<th>BC manual freqs.</th>
<th>Here you can select (ON) or cancel (OFF) the frequencies to be included in manual audiometry tests. The frequencies are selected using the Frequency knob. ON/OFF is selected using the Right Level knob.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default ON:</td>
<td>250, 500, 1000, 2000, 3000, 4000</td>
</tr>
</tbody>
</table>

Frequency change at Store

<table>
<thead>
<tr>
<th>BC store: Change freq.</th>
<th>Method for frequency change when you press Store. Xeta will automatically test frequencies above 1000 Hz in ascending order, and frequencies below 1000 Hz in descending order.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default</td>
<td></td>
</tr>
</tbody>
</table>
**Default:**

<table>
<thead>
<tr>
<th>Wrap</th>
</tr>
</thead>
</table>

**NO CHANGE**
If this parameter is set to “No change”, the setting will remain at the current frequency when you press **Store** (the frequency remains the same).

**WRAP**
If you press **Store** at the highest possible frequency, you switch to the lowest possible frequency. At other frequencies, pressing **Store** advances the frequency.

**BUTTERFLY**
If you press **Store** at the highest or the lowest possible frequency, you change to 1000 Hz.

**dB level new transducer**

<table>
<thead>
<tr>
<th>Start level</th>
</tr>
</thead>
<tbody>
<tr>
<td>Choice of initial volume level for a new client/ear, or change between different tests.</td>
</tr>
<tr>
<td>Adjustable in the range: -10 to 50 dB.</td>
</tr>
</tbody>
</table>

**dB level new frequency**

<table>
<thead>
<tr>
<th>New freq. level</th>
</tr>
</thead>
<tbody>
<tr>
<td>Choice of initial intensity when changing frequency.</td>
</tr>
</tbody>
</table>

**NO CHANGE**
The frequency remains the same, or adjustable in the range -10 to 50 dB.

**nn dB FIXED**
The initial level at each frequency is fixed to the predefined level (nn).

**nn dB ABOVE THR**
New fixed value above any previously located threshold value (nn).

**Masking presentation**

<table>
<thead>
<tr>
<th>Mask. present.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set mode for masking presentation:</td>
</tr>
</tbody>
</table>

**NORMAL**
The masking signal follows the masking interrupter. The masking signal appears when button is pressed.

**REVERSE**
The masking signal follows the masking interrupter. The masking signal disappears when button is pressed.
When using toggled masking presentation, the masking signal changes from being activated or deactivated each time the masking interrupter is pressed and released. Also, when using toggled masking presentation, the masking signal is deactivated as soon as the stimulus type (AC/BC), frequency, ear or patient is changed. This allows for setting the appropriate masking level before the masking signal is presented to the patient.

### Masking Assistant

<table>
<thead>
<tr>
<th>Mask. assistant</th>
<th>Enables indication of recommended masking (see description in The Masking Assistant ► 31).</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default</td>
<td>On</td>
</tr>
</tbody>
</table>

### Extended range

<table>
<thead>
<tr>
<th>Extended range</th>
<th>Selection of one of two modes (see description in Extended Range ► 19):</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto</td>
<td>Manual</td>
</tr>
<tr>
<td>Default</td>
<td>Auto</td>
</tr>
</tbody>
</table>

### Display

<table>
<thead>
<tr>
<th>Display</th>
<th>Controls display setup. Fixes one of the four left/right configurations:</th>
</tr>
</thead>
<tbody>
<tr>
<td>SIGNAL AS L/R</td>
<td>The signal for the left ear is shown on the left side, and that for the right ear on the right side. Masking is on the opposite side.</td>
</tr>
<tr>
<td>SIGNAL AS R/L</td>
<td>The signal for the left ear is shown on the right side, and that for the right ear on the left side. Masking is on the opposite side.</td>
</tr>
<tr>
<td>FIX SIGNAL ON L</td>
<td>The signal is shown on the left side, and masking on the right side.</td>
</tr>
<tr>
<td>FIX SIGNAL ON R</td>
<td>The signal is shown on the right side, and masking on the left side.</td>
</tr>
</tbody>
</table>

### Level knob

<table>
<thead>
<tr>
<th>Level knob</th>
<th>Controls the functions of the Left and Right Level knobs:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Always use left</strong></td>
<td>The <strong>Left Level</strong> knob controls the signal and the <strong>Right Level</strong> knob controls masking.</td>
</tr>
<tr>
<td>--------------------</td>
<td>----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Always use right</strong></td>
<td>The <strong>Right Level</strong> knob controls the signal and the <strong>Left Level</strong> knob controls masking.</td>
</tr>
<tr>
<td><strong>Follow display</strong></td>
<td>The stimuli (signal/masking) controlled by the <strong>Left</strong> and <strong>Right Level</strong> knobs correspond to the placing (left/right) of the stimuli on the display.</td>
</tr>
</tbody>
</table>

### Auto delete

<table>
<thead>
<tr>
<th><strong>Auto delete</strong></th>
<th>Automatically deletes the oldest patient record to free memory space as required.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Default</strong></td>
<td>On</td>
</tr>
</tbody>
</table>

### AC transducer

<table>
<thead>
<tr>
<th><strong>AC transducer</strong></th>
<th>Choose between calibrated headphones.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Note</strong></td>
<td>If the wrong headphone is selected compared to the one that is physically connected to Xeta, the measurements will be incorrect!</td>
</tr>
<tr>
<td>• - - - (None)</td>
<td></td>
</tr>
<tr>
<td>• TDH39 (Use this setting also for ME 70 transducers)</td>
<td></td>
</tr>
<tr>
<td>• EAR3A (E-A-R-TONE® 3A)</td>
<td></td>
</tr>
</tbody>
</table>

### BC transducer

<table>
<thead>
<tr>
<th><strong>BC transducer</strong></th>
<th>Choose between calibrated bone conductors.</th>
</tr>
</thead>
<tbody>
<tr>
<td>• - - - (None)</td>
<td></td>
</tr>
<tr>
<td>• B-71M (Mastoid)</td>
<td></td>
</tr>
</tbody>
</table>

### Pulse frequency

<table>
<thead>
<tr>
<th><strong>Pulse frequency</strong></th>
<th>Sets the pulse frequency:</th>
</tr>
</thead>
<tbody>
<tr>
<td>• 0.25 to 2.50 Hz</td>
<td></td>
</tr>
</tbody>
</table>
### Impulse length

<table>
<thead>
<tr>
<th>Stimulus timing</th>
<th>Sets the fixed period of time during which the signal will be presented when the Timed button is pressed.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• 0.25 to 2.50 sec.</td>
</tr>
</tbody>
</table>

### Warble modulation size

<table>
<thead>
<tr>
<th>Warble range</th>
<th>Sets modulation size as a %.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Example: At 5% the signal modulates 5% in relation to default frequency.</td>
</tr>
<tr>
<td></td>
<td>• 1 to 25%</td>
</tr>
</tbody>
</table>

### Warble frequency

<table>
<thead>
<tr>
<th>Warble frequency</th>
<th>• 1 Hz to 20 Hz</th>
</tr>
</thead>
</table>

### Internal beep

<table>
<thead>
<tr>
<th>Internal beep</th>
<th>Switches the internal beeper in connection with the patient’s response switch, and under item change in Setup, ON or OFF. Fault beeps are not removed.</th>
</tr>
</thead>
</table>

### Baud rate

<table>
<thead>
<tr>
<th>Baudrate</th>
<th>Selection of baud rate for RS232 interface.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• 9600, 19200, 38400, 57600 (default value).</td>
</tr>
<tr>
<td>Default:</td>
<td>• 57600</td>
</tr>
</tbody>
</table>

### Light intensity in LEDs

<table>
<thead>
<tr>
<th>Light intensity</th>
<th>Selection of brightness in LEDs (All LEDs are lit). Use Right Level knob to adjust.</th>
</tr>
</thead>
</table>

### Display brightness

<table>
<thead>
<tr>
<th>Disp. brightness</th>
<th>Changes the brightness of the display. Use Right Level knob to adjust.</th>
</tr>
</thead>
</table>

### Reset device settings

<table>
<thead>
<tr>
<th>Device settings</th>
<th>Activates MADSEN Xeta’s default setting for the relevant test. All settings are set to their “default” values.</th>
</tr>
</thead>
</table>
### Device settings

<p>| | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Frequency:</td>
<td>• 1000 Hz</td>
</tr>
<tr>
<td>2.</td>
<td>Ear:</td>
<td>• Left</td>
</tr>
<tr>
<td>Prime transducer:</td>
<td></td>
<td>• AC</td>
</tr>
</tbody>
</table>

All other On/Off settings are as default set to Off.

<p>| | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>3.</td>
<td>Reverse state</td>
<td>• (On/Off)</td>
</tr>
<tr>
<td>4.</td>
<td>Warble state</td>
<td>• (On/Off)</td>
</tr>
<tr>
<td>5.</td>
<td>Pulse state</td>
<td>• (On/Off)</td>
</tr>
<tr>
<td>6.</td>
<td>Timed impulse state</td>
<td>• (On/Off)</td>
</tr>
<tr>
<td>7.</td>
<td>Prime Transducer</td>
<td>• AC/BC</td>
</tr>
</tbody>
</table>

For each prime transducer the masking settings are:

<p>| | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>8.</td>
<td>AC masking</td>
<td>• (On/Off)</td>
</tr>
<tr>
<td>9.</td>
<td>MI masking</td>
<td>• (On/Off)</td>
</tr>
<tr>
<td>10.</td>
<td>Lock state</td>
<td>• (On/Off)</td>
</tr>
</tbody>
</table>

### Default setting

<table>
<thead>
<tr>
<th>Default settings</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>AC manual freqs.</td>
<td>• All freqs. on, except 125, 750, 1500</td>
<td></td>
</tr>
<tr>
<td>AC Store: Change freq.</td>
<td>• BUTTERFLY</td>
<td></td>
</tr>
<tr>
<td>BC manual freqs.</td>
<td>• All freqs. on, except 750, 1500</td>
<td></td>
</tr>
<tr>
<td>BC Store: Change freq.</td>
<td>• WRAP</td>
<td></td>
</tr>
<tr>
<td>Start level</td>
<td>• 20 dB</td>
<td></td>
</tr>
<tr>
<td>New freq. Level</td>
<td>• No change</td>
<td></td>
</tr>
<tr>
<td>Mask. present.</td>
<td>• Toggled</td>
<td></td>
</tr>
<tr>
<td>Mask. assistant</td>
<td>• On</td>
<td></td>
</tr>
<tr>
<td>Extended range</td>
<td>• Auto</td>
<td></td>
</tr>
<tr>
<td>Display</td>
<td>• SIGNAL AS L/R</td>
<td></td>
</tr>
<tr>
<td>Level knob</td>
<td>• FOLLOW DISPLAY</td>
<td></td>
</tr>
<tr>
<td>Auto delete</td>
<td>• On</td>
<td></td>
</tr>
<tr>
<td>AC transducer</td>
<td>• First calibrated transducer</td>
<td></td>
</tr>
<tr>
<td>BC transducer</td>
<td>• First calibrated transducer</td>
<td></td>
</tr>
</tbody>
</table>
### Default settings

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Pulse frequency</td>
<td>• 1.50 Hz</td>
</tr>
<tr>
<td>Stimulus timing</td>
<td>• 1.50 Sec.</td>
</tr>
<tr>
<td>Warble range</td>
<td>• 5%</td>
</tr>
<tr>
<td>Warble frequency</td>
<td>• 5Hz</td>
</tr>
<tr>
<td>Internal beep</td>
<td>• On</td>
</tr>
<tr>
<td>Baudrate</td>
<td>• 57600 Baud</td>
</tr>
<tr>
<td>Light intensity</td>
<td>• n/a</td>
</tr>
<tr>
<td>Disp. brightness</td>
<td>• n/a</td>
</tr>
</tbody>
</table>
7 Testing a patient with MADSEN Xeta

7.1 Automatic tone testing

- Prepare the patient for testing as described in Preparing for testing ► 45.

Selecting the test
You can choose between:
- Press Auto Threshold for automatic threshold testing. Automatic Air Conduction testing ► 12,
- Press Auto Screening for automatic screening. Automatic Screening ► 13,

Test settings
- Change settings, if required, as described in MADSEN Xeta Test Settings ► 55.

7.2 Manual tone testing - getting started

- Prepare the patient for testing as described in.
- Change settings, if required, as described in MADSEN Xeta Test Settings ► 55.

Selecting the test
Select one of the following manual tone tests:
- Press Air for air conduction testing. Air Conduction threshold test (manual) ► 67,
- Press Bone for bone conduction testing. Bone Conduction threshold test (manual) ► 70,
  - If you are using masking, see Testing with masking ► 72.
- Press More and the appropriate function key to select a special test.
  - SISI (Short Increment Sensitivity Index) ► 74,
  - The Stenger test ► 77,
  - ABLB (Alternate Binaural Loudness Balance) ► 76.

Changing settings
- See MADSEN Xeta Test Settings ► 55 to change settings.

7.3 Air Conduction threshold test (manual)

Modified (ascending) Hughson-Westlake.

Prerequisites
- Press Air.
If required, select another stimulus type: Warble or Pulsed (an advantage when you test children).

If you want to use a predefined duration of the signal presentation when you press the Present Signal button, press Timed.

If masking is required, select the appropriate masking type: Press Contra Air or Mono Insert. See also Testing with masking ► 72.

If required, turn the Frequency knob to set the starting frequency: Typical starting frequency: 1000 Hz.
The signal is usually presented for each tone in the following order:
  1000 Hz and increasing frequencies
  followed by
  1000 Hz (cross check) and decreasing frequencies.

Set the initial level of the presented signal to an audible level: Turn the Level knob to 40 dB HL.
This is to familiarize the patient with the test signal. Other familiarization procedures may be preferred.

Test the better ear first. If this is unknown, start with the right ear. Press L<->R to select the ear you wish to test.

Give the Patient Response switch to the patient and explain how it should be operated (see The patient responder ► 47).

Testing

1. Press the Present Signal button (right or left) to present the tone to the patient for 1 to 1.5 seconds.

2. Use the corresponding Level knob to set the intensity to approx. 20 dB above the patient’s presumed threshold.
   If the patient does not respond to the presented signal, turn the Level knob to increase the signal level in steps of 10 dB until the patient responds.
3. Reduce the signal level by 20 dB until the patient does not respond to the signal.

4. Increase the signal level in steps of 5 dB and present the signal to the patient at each level until the patient responds to the signal.

5. Reduce the signal level by 10 dB and present signals at levels increased by 5 dB until the patient responds.

6. Repeat item 5, 1 to 3 times until the patient has responded 3 times at the same level.

   This level represents the hearing threshold at 1000 Hz based on 3-5 ascending series.

   In some situations, it may be satisfactory with two responses at the same level.

   If the patient has responded less than 3 times at the same level after 5 series, present a signal at 10 dB above the level where a response was last registered.

   Then repeat item 6.

7. When the threshold is determined, press Store to store that particular threshold in the selected patient record.

8. Select the next frequency.

   You can link the Store and Next Frequency functions, so that the test progresses with the next frequency when you press Store. See AC store: Change freq. ► 59.

9. Continue to use the right and/or left Level knob to increase/decrease intensities until you have determined all thresholds.

   **Note:** If the thresholds measured at 1000 Hz in the ear differ by 10 dB or more, even the other frequencies should be retested.

10. Continue to press Store after each threshold is found to store that particular threshold.

11. After each threshold is determined and stored, you will notice that as you turn the Level knob to scroll frequencies, each stored threshold at that particular frequency will be marked by an asterisk (*) and the relevant audiogram symbol indicating the stored threshold.

12. If you are not performing the test online with the OTOsuite Audiometry Module, plot the results in an audiogram sheet.

13. Repeat this procedure for the other ear.

   If the difference between the thresholds in the two ears is 40 dB or greater, it is recommended that you test the poorer ear again with masking applied to the better ear. See Testing with masking ► 72.

14. If required, select the next patient record (press Previous/Next) or press New Patient.
7.4 Bone Conduction threshold test (manual)

**Note** In Bone Conduction testing, masking is always necessary in order to determine in which ear the presented tone signal is actually heard. This is because of the reduced level of inter-aural attenuation.

**Note** Make sure that there are no interfering ambient sounds, particularly at low frequencies. If necessary, place the patient in a sound booth.

Prerequisites

- Press Bone.

- If required, select another stimulus type: Warble or Pulsed.

- Press the Reverse button to set the stimulus signal to continuous presentation (useful for placing the bone conductor correctly on the patient).

- Set the dB level to a level that will be heard clearly by the patient.

- Place the bone conductor on the patient. See Preparing for bone conduction testing ► 48.

- Find the best position for the bone conductor. Ask the patient to report when the tone seems the loudest.

- Make sure that the bone conductor stays securely in place with no contact to the pinna.

- Give the Patient Response switch to the patient and explain how it should be operated (see The patient responder ► 47).

- Press Reverse to deactivate the Reverse function.

- If you want to use a predefined duration of the signal presentation when you press the Present Signal button, press Timed.

- If masking is required, see Testing with masking ► 72.

- If required, turn the Frequency knob to set the starting frequency: Typical starting frequency: 1000 Hz. The signal is usually presented for each tone in the following order:

  - 1000 Hz and increasing frequencies,
  - followed by frequencies below 1000 Hz in descending order.

  The typical test frequencies are:

  - 250 Hz to 4000 Hz.
• Set the initial level of the presented signal to an audible level: Turn the Level knob to 40 dB HL.
  This is to familiarize the patient with the test signal. Other familiarization procedures may be preferred.

• If you intend to test both ears, test the better ear first. If this is unknown, start with the right ear. Press L<-->R to select the ear you wish to test.

**Testing**

1. Press the Present button (right or left) to present the tone to the patient for 1 to 1.5 seconds.

2. If the patient does not respond to the presented signal, turn the Level knob to increase the signal level in steps of 10 dB until the patient responds.

3. Reduce the signal level by 20 dB until the patient does not respond to the signal.

4. Increase the signal level in steps of 5 dB and present the signal to the patient at each level until the patient responds to the signal.

5. Reduce the signal level by 10 dB and present signals at levels increased by 5 dB until the patient responds.

6. Repeat item 5, 1 to 3 times until the patient has responded 3 times at the same level.
  This level represents the unmasked hearing threshold at 1000 Hz based on 3-5 ascending series.
  In some situations, it may be satisfactory with two responses at the same level.
  If the patient has responded less than 3 times at the same level after 5 series, present a signal at 10 dB above the level where a response was last registered.
  Then repeat items 3 to 6.

7. When the threshold is determined, press Store to store that particular threshold in the selected patient record.

8. Turn the Frequency knob to select the next frequency.
  You can link the Store and Next Frequency functions, so that the test progresses with the next frequency when you press Store. See AC store: Change freq. ➤ 59.
9. Continue to use the right and/or left Level knob to increase/decrease intensities until you have determined all thresholds.

10. Continue to press Store after each threshold is found to store that particular threshold.

11. After each threshold is determined and stored, you will notice that as you turn the Level knob to scroll frequencies, each stored threshold at that particular frequency will be marked by an asterisk (*) and the relevant audiogram symbol indicating the stored threshold.

12. If you are not performing the test online with the OTOsuite Audiometry Module, plot the results in an audiogram sheet.

13. Repeat this procedure for the other ear.

Note • If the difference between the air conducted threshold and the unmasked bone conduction threshold of the same ear is 15 dB or greater, it is recommended that you retest bone conduction thresholds with masking applied to the contralateral ear. See Testing with masking ► 72.

14. If required, select the next patient record (press Previous/Next) or press New Patient.

7.5 Testing with masking

See

• Preparing for testing with masking ► 49,

and

• The Masking Assistant ► 31.

7.5.1 Air conduction with masking - suggested procedure

Prerequisites

The unmasked hearing thresholds have first been determined as described in Air Conduction threshold test (manual) ► 67.

Prerequisites as in Air Conduction threshold test (manual) ► 67.

• Prepare the patient for testing with masking. See Preparing for testing with masking ► 49.

• It is recommended to use the default setup used in connection with selecting Contra Air and Mono Insert for presenting the masking signal as continuous presentation.

This means that you will not be using the Interrupter button to control the masking signal.
Testing
1. Press Contra Air to activate contralateral masking.
2. Set the masking level at the threshold of the masking ear and make sure that it is heard by the patient.
   - If it is not, increase the masking level.
3. Present the tone to the test ear at the unmasked threshold level.
   - If the tone is not heard, increase the level in 5 dB steps until the patient responds.
4. When the patient responds, increase the masking level in 5 dB steps.
   - After each increase, present the tone no more than twice. The tone is considered heard if the patient responds at least once.
   - If the tone is heard when the masking level has been increased with at least three 5 dB steps, the so-called masking plateau has been reached and the test tone level is considered the masked hearing threshold level.
5. If the tone is not heard when the masking level is increased, increase the test tone level until the tone is heard by the patient.
   - Repeat from step 4.
6. If the test tone level at the masking plateau (established in step 4) is within 5 dB from the unmasked threshold level, you can skip step 7.
7. Keep the established masking level and confirm the masked hearing threshold level. To do so:
   - Decrease the test tone level by 10 dB and increase in 5 dB steps.
   - The patient should respond within 5 dB from the previously determined masked threshold level.
   - If not, repeat from step 2.
8. If required, test the remaining frequencies in the same way and switch to the other ear.

7.5.2 Bone conduction with masking - suggested procedure

Prerequisites
- Prepare the patient for testing with masking. See Preparing for testing with masking ➤ 49.
- It is recommended to use the default setup used in connection with selecting Contra Air and Mono Insert for presenting the masking signal as continuous presentation.
  - This means that you will not be using the Present button to control the masking signal.

Testing
1. Establish the unmasked bone threshold. If this has been done previously, and a different level is established in this step, do not overwrite the previously recorded threshold. The conditions may have changed if the masking transducers were placed following the first test (for example due to the occlusion effect).
2. Press Contra Air or Mono Insert to activate masking.
3. Set the masking level at the air conduction threshold of the masking ear and make sure that it is heard by the patient.
   - If it is not, increase the masking level.
4. Present the tone to the test ear at the previously confirmed unmasked bone conduction threshold level.
   - If the tone is not heard, increase the level in 5 dB steps until the patient responds.
5. When the patient responds, increase the masking level in 5 dB steps.
After each increase, present the tone no more than twice. The tone is considered heard if the patient responds at least once.

If the tone is heard when the masking level has been increased with at least three 5 dB steps, the so called masking plateau has been reached and the test tone level is considered the masked hearing threshold level.

6. If the tone is not heard when the masking level is increased, increase the test tone level until the tone is heard by the patient.
   Repeat from step 5.

7. If the test tone level at the masking plateau (established in step 5) is within 5 dB from the unmasked threshold level, you can skip step 8.

8. Keep the established masking level and confirm the masked hearing threshold level. To do so:
   Decrease the test tone level by 10 dB and increase in 5 dB steps.
   The patient should respond within 5 dB from the previously determined masked threshold level.
   If not, repeat from 3.

9. If needed, test the remaining frequencies in the same way and switch to the other ear.

### 7.6 SISI (Short Increment Sensitivity Index)

**Note • This test is optional.**

The SISI Test was developed by Jerger and co-workers (Jerger, Shedd, and Harford, 1959) and was introduced as a procedure that was reliable and reasonably objective.

The test consists of superimposing brief bursts of 1 dB intensity increments on a sustained tone presented monaurally through earphones at a sensation level of 20 dB at each tested frequency.

The patient is instructed to report any jumps in loudness detected while listening to the sustained tone for a period of about two minutes.

**Selecting the test**

1. Press **More** one or more times until SISI appears, and select the test by pressing **SISI** once.
   The top line shows the intensity (dB HL) to which the increments have been added, the test name, and the current SISI % score.
   The bottom line shows the number of dB increments currently transmitted, the test tone frequency and the scale of the SISI dB increments.

2. To start the SISI test press **Start/Pause**.
   The test stops automatically when the selected number of steps in intensity has been reached, and a beep is heard.

**Automatic scoring of responses**
- The percentage of correct responses (% score) is updated automatically.
Short increment indication
- The presence of a short increment in intensity is indicated by the little L or R test ear indicator in the display changing briefly to a rectangle,.
- To change the number of small increments turn the right Level knob.

Manual scoring of responses
- If the patient is unable to use the patient responder, but registers an increment heard in another way, you can press the Right Present Signal button to indicate that the tone was heard.

Pausing the test
- You can pause the SISI test by pressing Start/Pause again. During the pause "SISI" will flash in the display. To resume the test press Start/Pause once more.

Stopping the test
- During a pause, you can stop the test completely by pressing More.

Changing the dB level
- To change the dB level use the left LEVEL knob.

Changing the dB increments
- To change the dB increments use the right LEVEL knob (0.25 - 5dB).
  If you do so while the test is in progress, the counters are reset to zero and the test starts again from the beginning.

Changing number of increments
- To change the preset number of SISI dB increments transmitted during a test (10-50) press Setup once and use the right LEVEL knob. Then press Setup again to implement the new setting. While the SISI test is in progress, it is not possible to change the frequency or the number of dB increments.

7.6.1 Masking during SISI

Masking
To perform masking, press Contra Air.
- When you hold down the key, the masking intensity (instead of % score) and signal type are displayed.

Intensity
- To change the intensity press and hold the key and turn the right LEVEL knob

Signal type
- To change the signal type press and hold the key and turn the left LEVEL knob.

7.6.2 Using STORE in the SISI test

Note • A maximum of four different sets of SISI values can be stored for both left and right ear.
**Storing results**

1. When the test is completed for a frequency, press **Store** to store:
   - SISI % score, number of dB increments administered,
   - dB increment,
   - dB level for test signal and masking signal (if applicable).
   - An * symbol appears by the frequency and an x/o symbol for the left or right side.

2. Test the next frequency.

**Pausing the test**

- If you press **Store** while the test is in progress, the test will be stopped and saved with the current number of dB increments.
- Deleting specific values
- If you hold **Store** at a frequency at which data are stored, the values for that frequency will be deleted.

### 7.7 ABLB (Alternate Binaural Loudness Balance)

**Note** • This test is optional.

In this test a tone is transmitted at the same frequency to the left and right ear alternately. The patient must decide when the same volume is achieved in both ears. The patient indicates this by pressing the patient responder.

1. To select the test press **More** once or more until ABLB is shown.
2. Press ABLB once, and the test display is shown.
   - The top line shows the intensity for Right and Left channel and the test name.
   - The frequency of the test tone and the rate of alternation from ear to ear and back again (the alternating frequency) appear in the bottom line.

**Changing alternating frequency**

To change the alternating frequency:

1. Press **Setup** once and use the right LEVEL knob (0.25 - 2.5 Hz).
2. Press **Setup** again to implement the new setting.
3. You can present the signal in two ways:
   - present the signal to the patient by pressing the **Present Signal** button, or
   - press the **Reverse** button to present the signal continuously. You can then interrupt the test signal by pressing the **Present Signal** button.

Signal presentation (normal/Reverse) follows the normal rules (see Present signal buttons ▶ 23).
7.7.1 Using STORE in the ABLB (Fowler) test

**Storing equal volume values**

Press Store to store values of "equal volume".

- You can store up to five sets of measurements for each test frequency. If you try to save more than five sets of measurements for a given frequency, the message "No more STORE" is shown.

- You can store a maximum of four test frequencies, which you can select. If you have stored two or more measurements at the same frequency, you can turn the frequency knob to step through each of these measurements in turn before changing to the next frequency.

**Deleting individual measurements**

- To delete an individual measurement, press and hold Store while the measurement is displayed. Other measurements at the same frequency and at other frequencies remain unaffected.

If you start a test, and data is stored, you cannot just change the signal type. If you do, the system will not save the data. The message "Not allowed" is displayed and the button(s) that has/have been wrongly set flash in the correct position (three short flashes).

**Masking**

*Note* • *The audimeter cannot perform masking during this test.*

7.8 The Stenger test

*Note* • *This test is optional.*

The Stenger test is used to reveal a unilateral non-organic hearing loss in one ear.

1. Before you perform a Stenger test, measure the patient’s tone thresholds for the left and right ears.
2. To select the Stenger test press More (one or more times) until "STEN" appears.
3. Select the test by pressing STEN once. The following display appears:

```
   20   STEN   20
   L     1000 R
```

A tone is transmitted at the same frequency on the left and right sides simultaneously.

4. Press either of the **Present Signal** keys to present the tone to the patient.

**Changing dB level**

5. You can change the dB level setting separately for the right and the left ear: Set the dB level to 10 dB above the threshold in the better ear, and 10 dB below the threshold in the poorer ear.

6. You can present the signal in two ways:
   - present the signal to the patient by pressing the **Present Signal** button,
– press the REVERSE button to keep the signal continuous. You can then interrupt the test signal by pressing the Present Signal button.

Signal presentation (normal/REVERSE) follows the normal rules (see Present signal buttons ➤ 23).

7.9 Storing data

![Diagram of audiogram symbol]

The appropriate audiogram symbol is shown next to the tone dB level. If the signal intensity is changed, the symbol disappears, but reappears if the dB level is equal to the saved value.

7.9.1 Registering “no response”
If the patient cannot hear the test signal at maximum dB level, you can indicate this by pressing and holding Store until the “No response” symbol appears.

![Diagram of audiogram symbol]

7.9.2 Overwriting stored values
You can overwrite a stored threshold value (THR) with a new value (unless you have changed the test setup during the test). Simply press Store again.

7.9.3 Erasing a stored threshold
You can erase a stored audiogram point by pressing and holding Store until the point is erased.

7.9.4 Viewing stored values
1. To view stored values select the appropriate patient from the Patient list.
2. Use the Frequency knob to select the frequencies for the required side/ear.

Note • If a threshold is stored for the selected frequency, the stored stimulus (and masking level) is automatically selected and displayed.

7.10 Deleting patient records
You can delete patient records one by one or collectively.
1. To delete data use the Clear button.
2. You will be prompted to select “Current” or “All”.
3. Select and confirm your selection.
Configuring the Audiometry Module

You must run the Configuration Wizard before you can use the Audiometry Module and the audiometer for the first time. You can also use the wizard later to change specific settings or, for example, to repair the connection between the Audiometry Module and the audiometer.

1. Select Tools > Configuration Wizard...
2. Click on Configure... next to Audiometry.
3. Enter your selections and click on Next to continue the configuration or Finish to return to the Applications page of the configuration wizard.

<table>
<thead>
<tr>
<th>Audiometers</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connect to the device you wish to use for testing.</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Test Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show xxxx test type</td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Masking Assistant</th>
</tr>
</thead>
<tbody>
<tr>
<td>Masking Criteria</td>
</tr>
<tr>
<td>Air-Bone Gap Criterion</td>
</tr>
</tbody>
</table>
9 Communicating with the device

Connecting to the device
OTOsuite is designed to communicate with and display test data generated by Otometrics test devices.
- When you start up OTOsuite, click on the Control Panel icon. OTOsuite will automatically connect to the test device.
- See also the section "Activating the Control Panel" in the OTOsuite User Guide.

Firmware update
If a Firmware Update message appears, see:
- Updating device firmware ► 80

Information about the test device
To see information relating to the test device, select Help > About Device.

9.1 Reconnecting to the device
If the control panel for a test type is shown, and communication with the selected test device is interrupted, a message appears stating that there is no longer connection to the device.
- Click the Connect button on the Control Panel to reconnect to the selected test device.

9.2 Updating device firmware
If the OTOsuite software version contains a more recent firmware for the device, a message will appear when next you switch on the device.
It is recommended that you update the device firmware to make sure that the device and OTOsuite perform correctly.
- Follow the on-screen instructions.
10 Maintenance and calibration

MADSEN Xeta requires no preventive maintenance except for regular calibration of the transducers.
See Calibration ► 82.

10.1 Service and repair

It is recommended that you keep the packing material in which MADSEN Xeta was delivered. If you need to send it in for service, the original packing material will ensure protection against damage during transport, etc.

**Warning** • For the sake of safety and in order not to void the warranty, service and repair of electro-medical equipment should be carried out only by the equipment manufacturer or by service personnel at authorized workshops. In case of any defects, make a detailed description of the defect(s) and contact your supplier. Do not use a defective device.

**Note** • There are no user-serviceable parts inside the MADSEN Xeta cabinet.

10.1.1 Fuses

**Warning** • Risk of fire. Before replacing a fuse, first switch off the instrument and disconnect it from the mains power supply.

The fuse-holder is located above the AC power connector.
To remove a fuse:
• Unscrew the end of the fuse-holder using a screwdriver with a blade at least 6 mm wide.

**Fuse types**
The fuse is a push-fit in the end of the fuse-holder. When you replace fuses, use only fuses of type T 1 A H/250 V, 5 mm x 20 mm.

10.2 Cleaning

**Cleaning the device**
There are no specific requirements to sterilization or disinfection of the test device.
Make sure that the instrument is kept clean and free of dust:
• Remove dust using a soft brush.
• To clean the cabinet, use a soft, slightly damp cloth with a small amount of mild detergent on it.

**Caution** • Do not allow any moisture inside the instrument!
• To clean the display, use a dry cloth or soft brush. Note that the display is laminated for maximum readability and must therefore be treated with care.

Headphones
The headphones are in constant contact with the patient, and should therefore be kept clean.

Clean the headphones between patients, e.g. with a non-alcohol based antibacterial wipe, such as Audiowipes.

Eartips for Insert Earphones

Warning: To prevent cross-infection, use new eartips when you test the next client.

The eartips are disposable and therefore should not be cleaned or re-used. There are no special requirements for the disposal of the eartips.

Bone oscillator
Clean the bone oscillator between patients, e.g. with a non-alcohol based antibacterial wipe, such as Audiowipes.

10.3 Calibration

You can download new software to MADSEN Xeta, and if this involves no change to the transducers, MADSEN Xeta does not need recalibration.

Annual calibration
The audiometer, headphones, bone oscillators, and sound field speakers must be calibrated once a year by your authorized service department.

The audiometer is dispatched from the factory together with a Test Report (Calibration Certificate). The Test Report specifies the transducers that have been calibrated (i.e., those which have been supplied together with the instrument), according to which standards, and the equipment used for calibration. Results are listed for each transducer at all standard frequencies.

In general, the instrument is calibrated in dB HL and dB masking level using the stated reference equivalent thresholds; dB HL is related to sound pressure levels, dB SPL = dB re 20 µPa, and force levels (dB re 1 µN).

Caution: Note that calibration has been performed only on the transducers supplied! If you wish to use any other transducer for testing with the device, please contact your local distributor first.
11 Unpacking and installing

To install and get started with MADSEN Xeta and the OTOsuite Audiometry Module, follow the sequence below:

• Install OTOsuite on the PC before you connect to MADSEN Xeta from the PC.
• Unpack MADSEN Xeta (see Unpacking ► 83).
• Install MADSEN Xeta (see Installation ► 83)
• Run the OTOsuite Configuration Wizard to connect to and set up communication with MADSEN Xeta. (See Configuring the Audiometry Module ► 79).

11.1 Unpacking

Unpack the device carefully.
When you unpack the device and accessories, it is a good idea to keep the packing material in which they were delivered.
If you need to send the device in for service, the original packing material will protect against damage during transport, etc. Visually inspect the equipment for possible damage.
If damage has occurred, do not put the device into operation. Contact your local distributor for assistance. Check with the packing list to make sure that you have received all necessary parts and accessories. If your package is incomplete, contact your local distributor.

1. Check the Test Report (Calibration Certificate), make sure that the transducers (headphones, and bone oscillators) are the correct ones, and that they comply with the ordered calibration standards.

11.2 Storing

If you need to store MADSEN Xeta before you put it into operation, follow the guidelines below:

• Store MADSEN Xeta and accessories in the boxes provided to protect the equipment from damage.
• Store MADSEN Xeta and accessories in a dry environment.

See also Transport and storage ► 96.

11.3 Installation

This section provides you with instructions on how to assemble and install MADSEN Xeta.

**Note** • *Install OTOsuite on the PC before you connect to MADSEN Xeta from the PC.*

• Before you start using MADSEN Xeta, it is recommended that you leave it at room temperature for 30 minutes - particularly if it has been stored at very cold or warm temperatures, e.g. if it has been in a car.
• Read the user documentation before you connect or use MADSEN Xeta for the first time.

**Safety aspects**

To ensure safe performance, MADSEN Xeta must be correctly installed and the requirements listed in Standards and safety ► 91 and MADSEN Xeta ► 95 must be complied with.

**Cooling requirements**

There are no specific cooling requirements.
Caution • Do not place anything on top of MADSEN Xeta.

Caution • Make sure that MADSEN Xeta is placed in a well ventilated location.

- Place MADSEN Xeta in locations away from sources of heat and direct sunlight.
- MADSEN Xeta must not come into contact with liquids.

Connections
- Connect required accessories such as the headset, the bone conductor, and the Patient Response Switch to their respective connectors on the back panel according to the instructions in Air conduction ► 84, Bone conduction ► 85 and the locations described in Socket connections - rear panel ► 24.
- The headphone (AC transducer) is color coded as described in Socket connections - rear panel ► 24.

Installation sequence
1. Install OTOsuite on your PC.
2. Assemble and set up MADSEN Xeta.
   - Powering ► 84
   - Connecting to a pc ► 84
3. Switch on MADSEN Xeta.
4. Run the Configuration Wizard in OTOsuite to connect to and set up communication with MADSEN Xeta. See see Configuring the Audiometry Module ► 79.

11.3.1 Powering
1. Plug the power cord into the power socket of MADSEN Xeta. See Socket connections - rear panel ► 24.
2. Plug the other end of the power cord directly into an AC mains power outlet with a three-wire protective ground.

11.3.2 Connecting to a pc
1. You can connect MADSEN Xeta to a PC by using an RS 232 cable. See RS 232 interface ► 25.
2. If required, use a USB converter for your RS232 cable. See your accessories list to order.

11.3.3 Air conduction
See Socket connections - rear panel ► 24

Headphones

Headphones
- Connect the right and left cables (red and blue) from the transducers to the right and left AC sockets in the rear panel of MADSEN Xeta.
Insert phones
- Connect the insert phones to the right and left AC socket in the rear panel of MADSEN Xeta. They must be connected according to calibration.

- To verify the transducer used, press **Setup** and select **AC** to view the transducer selected. If required, select the desired transducer.

11.3.4 Bone conduction
- Connect the bone conduction transducer plug into the BC socket located in the rear panel of MADSEN Xeta.

See **Socket connections - rear panel** ➔ 24.
11 Unpacking and installing
12 Maximum non-destructive voltage

12.1 Input and output sockets

Maximum non-destructive input voltages for input and output sockets relative to earth connection when the instrument is switched on.

<table>
<thead>
<tr>
<th>Socket</th>
<th>Input Voltage</th>
<th>Output Voltage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mono insert socket</td>
<td>10 V AC</td>
<td>±10 V DC</td>
</tr>
<tr>
<td>AC left and right socket</td>
<td>10 V AC</td>
<td>±10 V DC</td>
</tr>
<tr>
<td>BC socket</td>
<td>10 V AC</td>
<td>±10 V DC</td>
</tr>
<tr>
<td>Patient Mic/Talk Back socket</td>
<td>12 V AC</td>
<td>±12 V DC</td>
</tr>
<tr>
<td>Patient responder socket</td>
<td>12 V AC</td>
<td>±12 V DC</td>
</tr>
<tr>
<td>AC mains inlet</td>
<td>1500 V AC</td>
<td>±370 V DC</td>
</tr>
</tbody>
</table>

12.2 RS232 interface sockets

<table>
<thead>
<tr>
<th>RS232 Pin</th>
<th>Input Voltage</th>
<th>Output Voltage</th>
</tr>
</thead>
<tbody>
<tr>
<td>pin 1 (nc)</td>
<td>240 V AC</td>
<td>±240 V DC</td>
</tr>
<tr>
<td>pin 2 (RxOut)</td>
<td>15 V AC</td>
<td>*±15 V DC</td>
</tr>
<tr>
<td>pin 3 (TxIn)</td>
<td>30 V AC</td>
<td>*±30 V DC</td>
</tr>
<tr>
<td>pin 4 (DTR)</td>
<td>30 V AC</td>
<td>*±30 V DC</td>
</tr>
<tr>
<td>pin 5 (ISO Gnd.)</td>
<td>30 V AC</td>
<td>±30 V DC</td>
</tr>
<tr>
<td>pin 6 (DSR)</td>
<td>30 V AC</td>
<td>*±30 V DC</td>
</tr>
<tr>
<td>pin 7 (RTSIn)</td>
<td>30 V AC</td>
<td>*±30 V DC</td>
</tr>
<tr>
<td>pin 8 (CTSout)</td>
<td>15 V AC</td>
<td>*±15 V DC</td>
</tr>
<tr>
<td>pin 9 (nc)</td>
<td>240 V AC</td>
<td>±240 V DC</td>
</tr>
</tbody>
</table>

Relative to pin 5 on the RS232 interface socket.
12 Maximum non-destructive voltage
### Abbreviations

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ABLB</td>
<td>alternate binaural loudness balance</td>
</tr>
<tr>
<td>AC</td>
<td>air conduction</td>
</tr>
<tr>
<td>AM</td>
<td>amplitude modulation</td>
</tr>
<tr>
<td>AUTO</td>
<td>automatic</td>
</tr>
<tr>
<td>BC</td>
<td>bone conduction</td>
</tr>
<tr>
<td>DEF</td>
<td>default</td>
</tr>
<tr>
<td>EXT</td>
<td>external</td>
</tr>
<tr>
<td>EXT. R.</td>
<td>extended range</td>
</tr>
<tr>
<td>FIX</td>
<td>fixed talk over level</td>
</tr>
<tr>
<td>FM</td>
<td>frequency modulation</td>
</tr>
<tr>
<td>FREQ</td>
<td>frequency</td>
</tr>
<tr>
<td>HL</td>
<td>hearing level</td>
</tr>
<tr>
<td>INT</td>
<td>internal</td>
</tr>
<tr>
<td>INT</td>
<td>interrupter</td>
</tr>
<tr>
<td>L</td>
<td>left</td>
</tr>
<tr>
<td>LCD</td>
<td>liquid crystal display</td>
</tr>
<tr>
<td>LED</td>
<td>light emitting diode</td>
</tr>
<tr>
<td>LEV</td>
<td>level</td>
</tr>
<tr>
<td>MANU</td>
<td>manual</td>
</tr>
<tr>
<td>MASK</td>
<td>masking</td>
</tr>
<tr>
<td>MIC</td>
<td>microphone</td>
</tr>
<tr>
<td>MOD</td>
<td>modulation</td>
</tr>
<tr>
<td>NBN</td>
<td>narrow band noise</td>
</tr>
<tr>
<td>o</td>
<td>right ear</td>
</tr>
<tr>
<td>P</td>
<td>parameters</td>
</tr>
<tr>
<td>R</td>
<td>right</td>
</tr>
<tr>
<td>SIG</td>
<td>signal</td>
</tr>
<tr>
<td>SISI</td>
<td>short increment sensitivity index</td>
</tr>
<tr>
<td>SPL</td>
<td>sound pressure level</td>
</tr>
<tr>
<td>STEN</td>
<td>Stenger</td>
</tr>
<tr>
<td>THR</td>
<td>threshold</td>
</tr>
</tbody>
</table>
### Abbreviations

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TON</td>
<td>tone</td>
</tr>
<tr>
<td>TRA</td>
<td>transducer</td>
</tr>
<tr>
<td>TRANSD</td>
<td>transducer</td>
</tr>
<tr>
<td>TTS</td>
<td>temporary threshold shift</td>
</tr>
<tr>
<td>VU</td>
<td>volume unit</td>
</tr>
<tr>
<td>WRB</td>
<td>warble</td>
</tr>
<tr>
<td>x</td>
<td>left ear</td>
</tr>
</tbody>
</table>
# Standards and safety

This manual contains information and warnings, which must be followed to ensure the safe performance of the devices and software covered by this manual. Local government rules and regulations, if applicable, should also be followed at all times. See Symbols used ► 91 and Warning notes ► 92.

## 14.1 Symbols used

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>❌</td>
<td>Electronic equipment covered by the Directive 2002/96/EC on waste electrical and electronic equipment (WEEE). All electrical and electronic products, batteries, and accumulators must be taken to separate collection at the end of their working life. This requirement applies in the European Union. Do not dispose of these products as unsorted municipal waste. You can return your device and accessories to Otometrics, or to any Otometrics supplier. You can also contact your local authorities for advice on disposal.</td>
</tr>
<tr>
<td>⚠️</td>
<td>Consult user manual for warnings and cautions.</td>
</tr>
<tr>
<td>📘</td>
<td>Consult user manual for warnings and cautions.</td>
</tr>
<tr>
<td>📘</td>
<td>Consult instructions for use.</td>
</tr>
<tr>
<td>⚠️</td>
<td>Complies with Type B requirements of IEC60601-1.</td>
</tr>
<tr>
<td>~</td>
<td>Suitable for alternating current only.</td>
</tr>
<tr>
<td>⚤</td>
<td>Power ON.</td>
</tr>
<tr>
<td>☐</td>
<td>Power OFF.</td>
</tr>
<tr>
<td>🟢</td>
<td>The device is susceptible to electrostatic discharge.</td>
</tr>
</tbody>
</table>
14 Standards and safety

14.2 Warning notes

1. This class of equipment is allowed in domestic establishments when used under the jurisdiction of a health care professional.

2. Keep the unit away from liquids. Do not allow moisture inside the unit. Moisture inside the unit can damage the instrument and it may result in a risk of electrical shock to the user or patient.

3. Do not use the instrument in the presence of flammable agents (gases) or in an oxygen-rich environment.

4. No parts may be eaten, burnt, or in any way used for purposes other than the applications defined in the Intended Use section of this manual.

5. The device and any device to be connected which has its own power supply should be turned off before any connections are established.

6. For safety reasons and due to effects on EMC, accessories connected to the equipment's outlet fittings must be identical to the type supplied with the system.

7. It is recommended that an annual calibration be performed on accessories containing transducers. Furthermore, it is recommended that calibration be performed if the equipment has suffered any potential damage (e.g. headphones dropped on the floor).

   Note that calibration has been performed only on the transducers supplied! If you wish to use any other transducer for testing with the device, please contact your local distributor first.

8. Unwanted noise may occur if the device is exposed to a strong radio field. Such noise may interfere with the performance of the device. Many types of electrical devices, e.g. mobile telephones, may generate radio fields. We recommend that the use of such devices in the vicinity of MADSEN Xeta be restricted.

9. There are no user-serviceable parts inside the MADSEN Xeta cabinet.

   For the sake of safety and in order not to void the warranty, service and repair of electro-medical equipment should be carried out only by the equipment manufacturer or by service personnel at authorized workshops. In case of any defects, make a detailed description of the defect(s) and contact your supplier. Do not use a defective device.

10. Changes or modifications not expressly approved by the manufacturer could void the user's authority to operate the equipment.

11. The device is susceptible to electrostatic discharge. Avoid touching the power inlet during use of the instrument.

12. The bone conductor cable and insert phone cable must not be removed or tampered with while MADSEN Xeta is powered on. Either disconnect the bone conductor or insert phone entirely from the instrument, or make sure that the instrument itself is disconnected from the power source.

13. When assembling an electro-medical system, the person carrying out the assembly must take into account that other connected equipment which does not comply with the same safety requirements as this product may lead to a reduction in the overall safety level of the system.
14. When selecting accessories connected to the RS232 socket of the device, the following points must be considered:
   - Use of connected equipment in a patient environment

15. Grounding continuity should be checked periodically.

16. Avoid using extension cables. The increased length of the cable may increase the resistance of the protective earth conductor beyond an acceptable level.

17. Operating at the wrong voltage may blow the fuses. For continued protection against fire hazard, replace fuses with the same type and rating only.

18. To comply with Medical Electrical Systems in IEC 60601-1 3.1 edition: 2012, computer and printer must be placed out of reach of the client, i.e. not closer than approx. 1.5 meters/5 ft.

14.3 The OTOsuite Audiometry Module

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>!</td>
<td>Used in error message dialogs if software program fails. See the detailed information in the dialog box.</td>
</tr>
</tbody>
</table>

14.4 Manufacturer

GN Otometrics A/S
Hoerskaetten 9, 2630 Taastrup
Denmark
☎ +45 45 75 55 55
✉ +45 45 75 55 59
www.otometrics.com

14.4.1 Responsibility of the manufacturer

The manufacturer is to be considered responsible for effects on safety, reliability, and performance of the equipment only if:

- All assembly operations, extensions, re-adjustments, modifications or repairs are carried out by the equipment manufacturer or personnel authorized by the manufacturer.
- The electrical installation to which the equipment is connected complies with EN/IEC requirements.
- The equipment is used in accordance with the instructions for use.

The manufacturer reserves the right to disclaim all responsibility for the operating safety, reliability and performance of equipment serviced or repaired by other parties.
15 Technical specifications

15.1 MADSEN Xeta

Type identification
MADSEN Xeta is type 1067 from GN Otometrics A/S.

Channels
2 separate and identical channels

Pure tone frequencies
AC: 11 standard 125 - 8000 Hz
BC: 250 - 8000 Hz standard frequencies
Insert phones: 125 - 8000 Hz standard frequencies
Accuracy: Better than 1 %.

Modulation
FM (Warble): 1 - 20 Hz in 1 Hz steps. Mod. width 1% - 25% in 1% steps
AM for SISI: 5, 4, 3, 1, 0.75, 0.50, 0.25 dB HL steps

Attenuator
5 dB HL step resolution over the entire range

Attenuator accuracy
In whole range: better than 3 dB HL
Between two consecutive attenuator positions:
5 dB HL step: better than 1 dB HL

HL Range
Maximum output will be limited by the transducer.
AC: -10 to 120 dB HL at mid-frequencies
BC: -10 to 70 dB HL at mid-frequencies

Masking
Narrow band noise

Total harmonic distortion
Air < 2.5 %
Bone < 5%

**Selectable transducers**

**AC:** TDH39 and insert phones, and insert phone mono.

**BC:** NB-71, B-71 (Mastoid)

**Mono insert:** Insert phone, mono

Transducer options depend on how MADSEN Xeta is calibrated.

**Outputs**

**AC:** 2 x mono jack, 1/4 "

**BC:** 1 x mono jack, 1/4 "

**Mono insert:** 1 x mono jack, 1/4 "

**Interrupter**

**Normal:** The signal is presented when the Present button is pressed.

**Reverse:** The signal stops when the Present button is pressed.

**Pulsed:** The signal is pulsed.

The pulse frequency can be adjusted in the range 0.25 to 2.5 Hz in 0.25 Hz steps.

**Timed:** The signal is presented for a preset period of time: 0.25 to 2.5 sec., in steps of 0.25 sec.

**Static force of transducer headbands**

**TDH 39:** 4.5 N ± 0.5 N

**B-71:** 5.4 N ± 0.5 N

**RS232 interface**

**Format:** 8 data bit, 1 stop bit

**Parity:** Equal

**Baud rate:** 9600, 19200, 38400, 57600 Baud

**Protocol:** XON/XOFF

**Transport and storage**

**Mode of operation:** Continuous

**Temperature:** +10°C to +35°C

**Air humidity:** 30% to 90%, non-condensing

**Air pressure:** 860 hPa to 1060 hPa.

(Operation at temperatures exceeding -20°C or +60°C may cause permanent damage.)
**Operating environment**

Mode of operation: Continuous

Temperature: +10°C to +35°C

Air humidity: 30% to 90%, non-condensing

Air pressure: 860 hPa to 1060 hPa.

(Operation at temperatures exceeding -20°C or +60°C may cause permanent damage.)

**Warm-up time**

< 10 min.

**Disposal**

MADSEN Xeta can be disposed of as normal electronic waste, according to WEEE and local regulations.

**Dimensions**

Approx. 355 x 415 x 130 mm, 14 x 16.5 x 5.1 inches

**Weight**

Approx. 4 kg, 8.8 lb.

**Power supply**

Internal, 100 - 120 V AC, 200 - 240 V AC, 50/60 Hz

**Power consumption**

< 60 VA

**Fuses**

T 1 A H/250 V

**Standards**

Audiometer: EN60645-1 and ANSI S3.6


EMC: IEC 60601-1-2:2007

**Miscellaneous**

Software-adjustable contrast/brightness on display and LEDs

Integral Talk Over microphone
15.2 Accessories

Standard accessories and optional accessories may vary from country to country - please consult your local distributor.

- TDH 39 headphones
- ME-70 headphones
- HOLMCO headphones
- Otometrics insert phones - stereo/mono
- Bone oscillators: NB-71, B-71
- Sound field loudspeakers
- PA 210 power amplifier for free-field testing
- Patient Responder(s)
- Mains cable
- Connection cables
- Audiogram pad
- MADSEN Xeta Reference Manual
- MADSEN Xeta User Guide

15.3 Notes on EMC (Electromagnetic Compatibility)

- MADSEN Xeta is part of a medical electrical system and is thus subject to special safety precautions. For this reason, the installation and operating instructions provided in this document should be followed closely.
- Portable and mobile high-frequency communication devices, such as mobile phones, may interfere with the functioning of MADSEN Xeta.

<table>
<thead>
<tr>
<th>Emission test</th>
<th>Compliance</th>
<th>Electromagnetic environment - guidance</th>
</tr>
</thead>
<tbody>
<tr>
<td>RF emissions</td>
<td>Group 1</td>
<td>MADSEN Xeta uses RF energy only for its internal function. Therefore, its RF emissions are very low and are not likely to cause any interference in nearby electronic equipment.</td>
</tr>
<tr>
<td>CISPR 11</td>
<td></td>
<td></td>
</tr>
<tr>
<td>RF emissions</td>
<td>Class A</td>
<td>MADSEN Xeta is suitable for use in all establishments other than domestic and those directly connected to the public low-voltage power supply network that supplies buildings used for domestic purposes.</td>
</tr>
<tr>
<td>CISPR 11</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Note: The emissions characteristics of this equipment make it suitable for use in industrial areas and hospitals (CISPR 11 class A). If it is used in a residential environment (for which CISPR 11 class B is normally required) this equipment might not offer adequate protection to radio-frequency communication services. The user might need to take mitigation measures, such as relocating or re-orienting the equipment.
### Guidance and manufacturer’s declaration - electromagnetic immunity for all equipment and systems

MADSEN Xeta is intended for use in the electromagnetic environment specified below. The user of MADSEN Xeta should ensure that it is used in such an environment.

<table>
<thead>
<tr>
<th>Immunity test</th>
<th>IEC 60601 test level</th>
<th>Compliance level</th>
<th>Electromagnetic environment - guidance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Electrostatic discharge (ESD)</td>
<td>±/ 6 kV contact</td>
<td>±/ 6 kV contact</td>
<td>Floors should be wood, concrete or ceramic tile. If floors are covered with synthetic material, the relative humidity should be at least 30%.</td>
</tr>
<tr>
<td>IEC 61000-4-2</td>
<td>±/ 8 kV air</td>
<td>±/ 8 kV air</td>
<td></td>
</tr>
<tr>
<td>Power frequency (50/60 Hz) magnetic field</td>
<td>3A/m</td>
<td>3A/m</td>
<td>Power frequency magnetic fields should be at levels characteristic of a typical location in a typical commercial or hospital environment.</td>
</tr>
<tr>
<td>IEC 61000-4-8</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

U\textsubscript{0} is the AC mains voltage prior to application of the test level.

### Guidance and manufacturer’s declaration - electromagnetic immunity for equipment and systems that are NOT life-supporting

MADSEN Xeta is intended for use in the electromagnetic environment specified below. The user of MADSEN Xeta should ensure that it is used in such an environment.

<table>
<thead>
<tr>
<th>Immunity test</th>
<th>IEC 60601 test level</th>
<th>Compliance level</th>
<th>Electromagnetic environment - guidance</th>
</tr>
</thead>
</table>
| Radiated RF                          |                       | 3V/m             | Portable and mobile RF communications equipment should be used no closer to any part of MADSEN Xeta, including cables, than the recommended separation distance calculated from the equation applicable to the frequency of the transmitter. Recommended separation distance:  
\[ d = 1.2 \sqrt{P} \]
\[ d = 1.5 \sqrt{P} \] for 80 MHz to 800 MHz
\[ d = 2.3 \sqrt{P} \] for 80 MHz to 2.5 GHz,
where \( P \) is the maximum output power rating of the transmitter in watts (W) according to the transmitter manufacturer and \( d \) is the recommended separation distance in metres (m). Field strengths from fixed RF transmitters, as determined by an electromagnetic site survey, \(^a\) should be less than the compliance level in each frequency range. \(^b\) Interference may occur in the vicinity of equipment marked with this symbol: [image]

\(^a\) 150 kHz to 80 MHz outside ISM bands
\(^b\) 3V/m
80 MHz to 2.5 GHz
15 Technical specifications

**Note 1:** At 80 MHz and 800 MHz the separation distance for the higher frequency range applies.

**Note 2:** These guidelines may not apply in all situations. Electromagnetic propagation is affected by absorption and reflection from structures, objects and people.

a. The ISM (industrial, scientific and medical) bands between 150 kHz and 80 MHz are 6.765 MHz to 6.795 MHz; 13.553 MHz to 13.567 MHz; 26.957 MHz to 27.283 MHz; and 40.66 MHz to 40.70 MHz.

b. The compliance levels in the ISM frequency bands between 150 kHz and 80 MHz and in the frequency range 80 MHz to 2.5 GHz are intended to decrease the likelihood that mobile/portable communications equipment could cause interference if it is inadvertently brought into patient areas. For this reason, an additional factor of 10/3 is used in calculating the recommended separation distance for transmitters in these frequency ranges.

c. Field strengths from fixed transmitters, such as base stations for radio (cellular/cordless) telephones and land mobile radios, amateur radio, AM and FM radio broadcast and TV broadcast cannot be predicted theoretically with accuracy. To assess the electromagnetic environment due to fixed RF transmitters, an electromagnetic site survey should be considered. If the measured field strength in the location in which MADSEN Xeta is used exceeds the applicable RF compliance level above, the MADSEN Xeta should be observed to verify normal operation. If abnormal performance is observed, additional measures might be necessary, such as reorienting or relocating MADSEN Xeta.

d. Over the frequency range 150 kHz to 80 MHz, field strengths should be less than 3 V/m.

### Recommended separation distances between portable and mobile RF communications equipment and MADSEN Xeta

<table>
<thead>
<tr>
<th>Rated maximum output power of transmitter W</th>
<th>Separation distance according to frequency of transmitter m</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>150 kHz to 80 MHz outside ISM bands</td>
</tr>
<tr>
<td></td>
<td>80 MHz to 800 MHz</td>
</tr>
<tr>
<td></td>
<td>800 MHz to 2.5 GHz</td>
</tr>
<tr>
<td>0.01</td>
<td>0.12</td>
</tr>
<tr>
<td></td>
<td>0.12</td>
</tr>
<tr>
<td></td>
<td>0.29</td>
</tr>
<tr>
<td>0.1</td>
<td>0.38</td>
</tr>
<tr>
<td></td>
<td>0.38</td>
</tr>
<tr>
<td></td>
<td>0.73</td>
</tr>
<tr>
<td>1</td>
<td>1.2</td>
</tr>
<tr>
<td></td>
<td>1.2</td>
</tr>
<tr>
<td></td>
<td>2.3</td>
</tr>
<tr>
<td>10</td>
<td>3.8</td>
</tr>
<tr>
<td></td>
<td>3.8</td>
</tr>
<tr>
<td></td>
<td>7.3</td>
</tr>
<tr>
<td>100</td>
<td>12</td>
</tr>
<tr>
<td></td>
<td>12</td>
</tr>
<tr>
<td></td>
<td>23</td>
</tr>
</tbody>
</table>

For transmitters rated at a maximum output power not listed above, the recommended separation distance d in meters (m) can be estimated using the equation applicable to the frequency of the transmitter, where P is the maximum output power rating of the transmitter in watts (W) according to the transmitter manufacturer.

**Note 1:** At 80 MHz and 800 MHz the separation distance for the higher frequency range applies.

**Note 2:** These guidelines may not apply in all situations. Electromagnetic propagation is affected by absorption and reflection from structures, objects and people.
## Index

### A

**Abbreviations** 89  
**AC** connection 24  
**AC** transducer  
  select headphones 62  
**Accessories**  
  **AC** connection 84  
  **BC** connection 85  
  connections 24  
  specifications 98  
**Air conduction**  
  **AC** connection 24  
  testing 67  
  with masking 72  
**Attenuator**  
  specifications 95  
**Audiogram**  
  combined,  
    enabling/disabling 29  
  show combined view, Audiogram  
    Module 29  
  show split view, Audiogram  
    Module 29  
  viewing frequency range 30  
  viewing left-right 29  
  viewing legend box 29  
  viewing right-left 29  
  work area in screen, Audiogram  
    Module 37  
**Audiogram symbols, Audiogram module** 41  
**Audiogram symbols, Xeta** 16  
**Audiometry**  
  basic functions 27  
  managing the client list 52  
  menu bar 28  
  OTOsuite toolbar 28  
**Auto Threshold testing** 19  
**Automatic Screening** 19

### B

**Baud**  
  rate setting 63  
**BC** connection 24-25  
**BC** transducer  
  select bone conductors 62  
**Beep**  
  function 17  
  ON/OFF, setting 63  
**bone conduction**  
  **BC** transducer 62  
**Bone conduction**  
  **BC** connection 24-25  
  button 18  
  testing 70  
**Butterfly** 59-60  
**Buttons** 16, 18  
  Air 17  
  Auto Screening 19  
  Auto Threshold 19  
  Bone 18  
  Clear 20  
  Contra Air, Masking 18  
  **dB** 23  
  Extended Range 19  
  Level Lock, Masking 18  
  LR 21  
  Mask Lock 18  
  Mono Insert, Masking 18  
  More 19  
  New Patient 20  
  present signal, left 23  
  Pulsed 18  
  Reverse 18  
  selecting tests 18  
  Setup 20  
  Start/Pause 24  
  STIMULUS 17  
  Store 22  
  Talk Over 23  
  Timed 18  
  Warble 18
Index

C
Cables
  connecting test equipment 46
Calibration 82
  certificate 82
Cleaning 81
Clear button 20
Client
  inspecting the ear 50
Client list 52
Client lists
  selecting 30
Combined audiogram
  enabling/disabling 29
Configuration Wizard 79
Connections
  AC 24
  accessories 24
  BC 24-25
  Patient response switch 25
  RS232 25
  supply voltage 25
Contra Air, Masking, button 18
Control Panel
  Audiology description 34
Controls 16
Curves and symbols 39
  selecting 30

D
Data
  storing 78
dB
  button 23
  level for new frequency 60
  level for new transducer 60
Default settings 64
Default test parameters 63
Delete
  records 20
Display 15
  setup 61
Display brightness 63

E
Ear
  selection 21
Extended range
  button 19
  timeout, setting 61
Frequency
  alternating tone frequency
    setup 20
  selecting test 19
  storing results 77
F
Fetch test results from
  audiometer 30
Firmware update, test devices
  (Aud.) 80
Fowler
  alternating tone frequency
    setup 20
  selecting test 19
  storing results 77
Frequency
  butterfly 59-60
  change test f. 22
  change with STORE, AC 59
  change with STORE, BC 59
  changing 23
  dB level for new f. 60
  pulse 62
  select AC manual 59
  select BC manual 59
  selecting pure tone types 95
  warble 63
  wrap 59-60
Frequency range, audiogram
  viewing 30
Front panel 16
  Air conduction button 17
  Auto Screening button 19
  Auto Threshold button 19
  Bone conduction button 18
  Clear 20
  Contra Air, Masking 18
  display 15
  Extended Range 19
  LR 21
  Mask.Lock 18
  Mono Insert, Masking 18
ON/OFF
- power switch 25
Output indicators 19
Output types 17
Overlays
- feature box:Feature box overlays 42
- viewing 29
Overview, instrument 15

Parameters
- AC frequency change at
  - STORE 59
  - AC transducer 62
  - auto delete 61-62
  - baud rate 63
  - BC frequency change at
    - STORE 59
    - BC transducer 62
  - dB level new frequency 60
  - dB level new transducer 60
  - default settings 64
  - display brightness 63
  - display setup 61
  - extended range timeout 61
  - impulse length 63
  - internal beep 63
  - Level knob 61
  - light in indicators 63
  - masking presentation 60
  - pulse frequency 62
  - select AC manual frequency 59
  - select BC manual frequency 59
  - set default test parameters 63
  - setup 55
  - shortcut 55
  - warble frequency 63
  - warble modulation size 63

Patient communication
- Mic. 24
  - Talk over 23
  - Patient list 52

Patient responder 31
Patient response
  - shown on front panel 22
  - switch connection 25
PC interface
  - cable connection 25
Power switch 25
Preparing for testing
  - connecting cables 46
  - inspecting the client’s ear 50
Present signal, left button 23
Presenting signal
  - reversing function 18
  - Start/Pause button 24
Pulsed button 18

Records
- deleting 20
Replacement
  - fuses 81
Response indicator 22
Reverse button 18
Right - Left audiogram
  - viewing 29
RS232 connection 25

Safety 91
Screening
  - automatic testing 19
Screens
  - Tone, Audiogram Module 36
Select ear 21
Select orientation
  - toolbar 30
Settings 55
  - changing 20
  - Control Panel 34
  - default s. 64
  - display brightness 63
Setup
  - parameters 55
  - Setup button 20
Shortcut
  parameters 55
SISI
  changing number of small increments 20
  selecting test 19
  storing results 75
Specifications 95
  accessories 98
Standards 91
Start/Pause button 24
Stimuli
  Level knob setting 61
Stimulus buttons 17
Store button 22
Storing 83
Storing data 78
storing results
  Fowler 77
  SISI 75
Supply voltage
  connection 25
Symbols 91
Symbols and curves
  selecting 30
Symbols, audiogram module 41
Symbols, audiogram, in Xeta 16
T
  Talk Over button 23
  Technical specifications 95
Test devices
  connecting 80
  information about 80
Test devices (Audiometry)
  firmware update 80
Test equipment
  connecting cables, Audiometry 46
Test frequency
  change 22
Test parameters
  set default 63
Test report 82
Test settings 55
  changing 20
Testing
  air conduction 67
  Auto Threshold 19
  Auto Screening 19
  bone conduction 70
  Extended Range 19
Tests
  controlling from Control Panel 34
  optional tests 19
  selecting tests 18
  Tone screen, Audiogram Module 36
Threshold
  automatic testing 19
  store t. 22
Timed button 18
Tone test
  the Tone screen, Audiogram Module 36
Toolbar
  Audiometry 28
  select orientation 30
Tools menu
  Curves and symbols 30
Tools menu (Aud)
  Client lists 30
  Curves and symbols 30
  fetch test results from audiometer 30
transducers
  BC 62
  AC 62
Transducers
  AC connection 24
  AC, headphones 62
  calibration 82
dB level for new t. 60
  specifications 96
U
Unpacking
  the test device 83
Unscheduled patients 47
Index

V
View menu
  audiogram legend 29
  combined audiogram 29
  frequency range 30
  left-right audiogram 29
  Masking Assistant 28
  Overlays 29
  right-left audiogram 29
View menu (Aud)
  audiogram legend 29
  combined audiogram 29
  frequency range 30
  masking assistant 28
  Overlays 29
Voltage
  maximum non-destructive 87

W
Warble
  frequency 63
  modulation size 63
Warble button 18
Warning notes 92
Wrap 59-60